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Safety Instructions
Read and Keep these Instructions

Warning

Important Safety Instructions

1 Read these instructions.

2 Keep these instructions.

3 Heed all warnings.

4 Follow all instructions.

5 Do not use this equipment near water.

6 Clean only with dry cloth.

7 Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8 Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce 
heat.

9 Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit 
from the equipment.

10 Only use attachments/accessories specified by the manufacturer.

11 For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold 
with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

12 Unplug this equipment during lightning storms or when unused for long periods of time.

13 Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as 
power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been ex-
posed to rain or moisture, does not operate normally, or has been dropped.

14 For products that are a Mains powered device:
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The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the 
equipment.

WARNING!

To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

ATTENTION! 

Pour réduire les risques d'incendie ou d'électrocution, n'exposez pas cet équipement à la pluie ou à l'humidité.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the 
other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your 
safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

15 For products containing a lithium battery:

WARNING!

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

ATTENTION!

Risque d'explosion si la batterie n'est pas remplacée correctement. Remplacez uniquement par un type identique ou équivalent. 
Jetez les piles usagées conformément aux instructions.

16 For products with a power switch: It should remain accessible after installation.

17 The equipment shall be used at a maximum ambient temperature of 40° C.

18 This unit is provided with a power supply cord set suitable for 120V AC input only (for U.S.A. and Canada). For other than U.S.A. 
and Canada, a qualified person must provide for use with this unit, an appropriate, approved power supply cord set which is in com-
pliance with the end use country requirements and has a minimum cross-sectional area of 1.0mm2.

19 For products with more than one power cord:

WARNING!

This unit has more than one power supply cord. Discon- nect two power supply cords before servicing to avoid electrical shock.

ATTENTION!

Cet appareil comporte plus d’un cordon d’alimenta- tion. Afin de prévenir les chocs électriques, débrancher les deux cor- dons 
d’alimentation avant de faire le dépannage.

20 For products with an operator-accessible fuse:

CAUTION:

For continued protection against risk of fire, replace only with same type and rating of fuse.

ATTENTION:

Pour ne pas compromettre la protection contre les risques d’incendie, remplacer par un fusible de même type et de même car-
actéristiques nominales.
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Rack-Mount Safety Instructions

1 Elevated Operating Ambient—If installed in a closed or multi-unit rack assembly, the operating ambient temperature of the rack en-
vironment might be greater than room ambient. Therefore, consider installing the equipment in an environment compatible with the 
maximum ambient temperature (Tma) specified by the manufacturer.

2 Reduced Air Flow—Installation of the equipment in a rack should be such that the amount of air flow required for safe operation of 
the equipment is not compromised. Make allowances for cooling air to be available to the front panel surface and no restrictions at 
the rear.

3 Mechanical Loading—Mounting of the equipment in the rack should be such that a hazardous condition is not achieved due to un-
even mechanical loading.

4 Circuit Overloading—Consideration should be given to the connection of the equipment to the supply circuit and the effect that over-
loading of the circuits might have on over-current protection and supply wiring. Appropriate consideration of equipment nameplate 
ratings should be used when addressing this concern.

5 Reliable Earthing—Reliable Earthing of rack-mounted equipment should be maintained. Particular attention should be given to sup-
ply connections other than direct connections to the branch circuit (for example, use of power strips).

LED Safety Notices

Avid hardware might contain LED or Laser devices for communication use. These devices are compliant with the requirements for 
Class 1 LED and Laser Products and are safe in the intended use. In normal operation the output of these laser devices does not exceed 
the exposure limit of the eye and cannot cause harm.

Environmental Compliance

Proposition 65 Warning

This product can expose you to chemicals including Pb and Pb compounds, which is known to the State of California to cause 
cancer and birth defects or other reproductive harm. For more information go to www.P65Warnings.ca.gov.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material—special handling may apply, see www.dtsc.ca.gov/hazardous waste/perchlorate.”

Recycling Notice

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your re-
sponsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical 
and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve nat-
ural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about 
where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you 
purchased the product.
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EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards:

• FCC Part 15 Class B

• ICES-003 Class B

• BS/EN, EN 55032 Class B

• AS/NZS CISPR 32 Class B

• CISPR32 Class B

• BS/EN, EN 61000-3-2

• BS/EN, EN 61000-3-3

• BS/EN, EN 55035

FCC Notice: Class B Equipment

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment gen-
erates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try and correct the interference by one or more of the following measures:

• Reorient or locate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Avid, could void the user's authority to operate the equipment.

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI connector hoods in order to maintain com-
pliance with FCC Rules and Regulations.

Any modifications to the unit, unless expressly approved by Avid, could void the user's authority to operate the equipment.

Canadian ICES-003 Class B Notice

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Australian Compliance

Korean EMC Compliance

Safety Compliance

This equipment has been tested to comply with USA, Canadian, EU and International safety certification standards: UL 62368-1:2014, 
CAN/CSA 62368-1-14 and IEC//BS/EN 62368-1:2014 (2nd Edition), A11 2017.

Avid Technology Inc., has been authorized to apply the appropriate NRTL mark on its compliant equipment.
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Power Safety Input Rating

Regulatory Model Number: MTRX II
100–240VAC, 50–60Hz, 120VA Max.

United Kingdom Compliance
(EMC, Safety, and RoHS)

Avid Tech. EU LTD
20 Station Road
Gerrards Cross
England SL9 8EL

CE Compliance
(EMC, Safety, and RoHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC 
Directive 2014/30/EU, Low Voltage Directive 2014/35/EU and RoHS Recast Directive 2011/65/EU.
 vii
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Chapter 1: Introduction

Pro Tools | MTRX II

Welcome to Pro Tools | MTRX™ II for Pro Tools Ultimate™ software running with Pro Tools | HDX™ or Pro Tools | HD™ Native 
hardware. MTRX II is an extremely capable multi-channel audio converter, router, and monitor mixer. MTRX II has eight slots for 
optional I/O cards, including DigiLink, MADI, Dante with SRC, 3G SDI, AES/EBU, pristine 8-channel analog line and micro-
phone input, and 8-channel analog line as installable card options. 

MTRX II supports an optional Thunderbolt 3 module with 256 bidirectional channels for connection to a computer. Integrated dig-
ital I/O provides 64 channels of DigiLink™, 256 channels of Dante™, and 64 channels of MADI. Sample rates are supported from 
44.1 to 348 kHz and a resolution of 32-bit floating point over Thunderbolt 3 or 24-bit resolution with DigiLink. An optional 
128-channel mini MADI I/O module can be also installed.

The MTRX II routing engine provides a 4,096 x 4,096 matrix where all inputs and outputs can be patched in any combination. In 
addition a 512x64 channel summing processor and a built-in 1,024 filter SPQ equalizer is also available for Control Room Moni-
toring and Cue sends.

Pro Tools | MTRX II Overview
Pro Tools | MTRX II features:

• 64-channel audio interface for Pro Tools with two DigiLink Mini ports (Primary and Primary/Expansion).

• Built-in MADI coaxial connections for up to 64 channels of digital I/O at all sample rates.

• Ethernet IP audio interface for 256 I/O channels using Dante with configurable redundant network (with an additional 128 Chan-
nels using the Dante Expansion card).

• Digital router and format converter between all analog and digital inputs and outputs.

• Sample rates of 44.1–384 kHz as well as DSD64/DSD 128 with high precision internal clock and PLL.

• Sample rate can be adapted to the setting of an external device.

• Synchronization by Word Clock, AES11, Video, and all digital audio inputs.

• All settings are controlled over Ethernet (or Thundebolt 3) using DADman software (macOS or Windows).

• Ultra low-noise internal fan with speed adaptation to the temperature.

MTRX II is operated using DADman control software. The control channel is over Ethernet or Thunderbolt connection to the 
computer.

With the optional Thunderbolt 3 module installed, MTRX II can be used with any tier of Pro Tools.
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Pro Tools | MTRX II lets you install optional I/O expansion cards in any of the eight back panel slots that include:

• Up to 64 analog channels depending on the configuration of installed Analog I/O Expansion Cards:

• Pro Tools | MTRX II 8 Line Pristine AD Card provides eight channels of line-level analog inputs.

• Pro Tools | MTRX II 2 Mic/Line Pristine AD Card provides two channels of analog inputs and mic preamps with relay-based gain 
circuit—an ideal low-cost option for talk-back and tracking—includes microphone preamplifiers with relay-based gain circuits.

• Pro Tools | MTRX II 8 Mic/Line Pristine AD Card provides eight channels of analog inputs and mic preamps with relay-based gain 
circuits.

• Pro Tools | MTRX II Pristine 8 DA Card provides eight channels of line-level analog outputs with an output level control.

• Digital I/O Expansion Cards:

• Pro Tools | MTRX II 8 AES3 I/O Card provides eight line AES3 inputs and outputs (16 channels) with built-in sample rate con-
version.

• Pro Tools | MTRX II Dual SDI/HD/3G Card provides 2 x 16 channels of SDI/HD/3G connections with built-in sample rate con-
version.

• Pro Tools | MTRX II Dual MADI I/O Card provides up to 128 channels of MADI inputs and outputs through two optical SFP ports, 
and also provides SRC on input.

• Pro Tools | MTRX II MADI mini-module for the Base Unit provides additional one or two 64-channel I/O coaxial or optical MADI 
module to the chassis.

• Pro Tools | MTRX II Dante 128 Card provides up to 128 channels of high-density, low-latency digital audio using Dante (128 chan-
nels at 44.1 kHz or 32 channels at 192 kHz), and also provides Sample Rate Conversion (SRC).

• DigiLink Expansion Card:

• Pro Tools | MTRX II DigiLink Card provides 2 DigiLink ports to connect to HDX cards, HD Native, or additional audio interfaces 
(such as HD MADI I/O) for up to 64 channels of DigiLink I/O per card at all sample rates.

MTRX II is compliant with the Dante Controller and Dante Virtual Sound Card, and also supports Dante Domain Manager.
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Clock and Synchronization System
The MTRX II clock system supports various internal and external clock modes. MTRX II has a precise and very high quality internal 
sample clock generator, which can also be clocked from an external clock signal by means of a very accurate Digital Phase Locked Loop 
(DPLL) system.

The MTRX II clock system has to be set to the correct sample rate with which the units should operate. This is the case both when op-
erating with the internal sample clock generator as master clock, or when synchronized to an external clock source. The sample rates 
supported are based on either 44.1 or 48 kHz sampling. An external clock must always have a correct base rate in relation to the sample 
rate used.

The sample rate with which the MTRX II should operate can be set manually using DADman software. You can also set the sample rate 
from Pro Tools. When using the IP Audio interface powered by Dante, the sample rate of the Dante I/O node to the IP Audio network 
can be set to follow the sample rate of the MTRX II. When multiple MTRX II units are operating in the same set up or IP Audio network, 
they must all be set to the same sample rate.

MTRX II sample clock circuit
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Clock input

Digital signal input
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IP Audio
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Routing Matrix
Pro Tools | MTRX II provides a powerful routing matrix. All input signals can be patched to one or more outputs on a mono-channel 
basis, so MTRX II is also a digital patch bay. Configure MTRX II routing using DADman software. In order to set up the correct signal 
flow in MTRX II, the correct connections have to be set in the matrix using DADman software. Any of the analog or digital inputs in-
stalled in the MTRX II can be patched to any analog or digital output, or can be routed to multiple outputs. For example, with sixteen 
analog input channels, each one can be routed to Pro Tools and from Pro Tools to a MADI output. At the same time, another two chan-
nels from Pro Tools can be routed to stereo analog outputs on MTRX II. Additionally, each of the AES/EBU input channels can be 
routed to matching optical MADI outputs.

It is essential that all digital signals connected to the MTRX II are synchronized to the same master clock.

In order to patch IP Audio channels between different devices, use the Dante Controller software tool from Audinate.

MTRX II block diagram
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MTRX II router matrix
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System Requirements and Compatibility Information
Pro Tools | MTRX II is supported by a compatible version of Pro Tools Ultimate software with Pro Tools | HDX or HD Native hardware. 
MTRX II with the optional Thunderbolt 3 Option module is compatible with all tiers of Pro Tools software (please note that the available 
I/O is limited by the tier of Pro Tools you are running).

Avid recommends using a grounded, switchable power supply with MTRX II for powering the unit on and off.

For the latest Pro Tools | MTRX II system requirements and resources, visit https://www.avid.com/MTRX-Support.

For complete system requirements and a list of qualified computers, operating systems, storage solutions, peripherals, control surfaces, 
and third-party devices, visit www.avid.com/compatibility.

For Pro Tools | MTRX II FAQ, visit https://avid.secure.force.com/pkb/articles/en_US/FAQ/Pro-Tools-MTRX-Support.

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

Conventions Used in Pro Tools Documentation
Pro Tools documentation uses the following conventions to indicate menu choices, keyboard commands, and mouse commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

MTRX II require Pro Tools 2022.4 or higher with HDX and HD Native systems.

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click with the mouse

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your Pro Tools system.

Important Notices include information that could affect your Pro Tools session data or the perfor-
mance of your Pro Tools system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid documentation.
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6

https://www.avid.com/MTRX-Support 
http://www.avid.com/compatibility

https://avid.secure.force.com/pkb/articles/en_US/FAQ/Pro-Tools-MTRX-Support



Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you do not have one). Register your 
purchase online, download software, updates, documentation, and other resources.

www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support), download software updates and the latest online manuals, browse compatibility 
documents for system requirements, search the online Knowledge Base or join the worldwide Avid user community on the User Con-
ference.

www.avid.com/support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training center, 
or view video tutorials and webinars.

www.avid.com/education

Video Tutorials
The Get Started Fast with Pro Tools series of online videos provide tutorials to help if you are new to Pro Tools. They also provide vid-
eos for the experienced user that introduce new features found in the latest versions of Pro Tools.

www.avidblogs.com/get-started-fast-with-pro-tools/

The MTRX in Focus series of video tutorials on YouTube dedicated to the MTRX family of products.

Products and Developers
Learn about Avid products, download demo software, or learn about our Development Partners and their plug-ins, applications, and 
hardware.

www.avid.com/products
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Chapter 2: Installation and Registration

Installing Pro Tools | MTRX II involves the following:

1 Unpacking MTRX II

2 Registering your MTRX II

3 Downloading and installing software

4 Authorizing Pro Tools DigiLink I/O License with iLok License Manager

5 Installing Expansion cards

6 Installing Option modules

7 Rack mounting MTRX II (optional)

8 Connecting cables

9 Configuring network settings

Unpacking MTRX II
Before you get started installing Pro Tools | MTRX II, unpack the box, which contains the following:

• MTRX II chassis

• 1 IEC power cable

• Welcome card with redemption code and serial number

Keep the Welcome card on hand to register your MTRX II and access software downloads and firmware updates. Set the power ca-
ble aside until you are ready to start connecting cables. Remove the MTRX II from the box and packaging, and place it on a hard 
and dry surface.

Register Pro Tools | MTRX II and Activate your Avid Master Account
Your Pro Tools | MTRX II includes an Activation card with a code that lets you register the unit, and access software, firmware, 
and documentation downloads.
Chapter 2: Installation and Registration 8



To register and access Pro Tools | MTRX II–related downloads through your Avid Master Account:

1 Locate the Activation card.

2 Visit https://www.avid.com/register and continue with the next step.

3 Log in to your Avid Master Account. If you do not already have an Avid Master Account, create a new one and log in.

4 Enter the redemption code on the Registration card and click Register.

You are directed to the My Products page for your Avid Master Account.

Download Software
Once you have registered MTRX II, you can download software and firmware updates from your Avid Master Account. For DADman 
installation and configuration instructions, see Installing and Configuring DADman Software

To download MTRX II software and firmware:

1 Log in to your Avid Master Account (if you are not already).

2 Under My Products, click the My Products and Subscriptions link.

3 Under the My Products tab, click Pro Tools | MTRX II.

4 To the right of Product Details and Download Links, click Show.

5 Click the links for any Read Me documentation about firmware and/or software updates. Review this information carefully to ensure 
the successful installation of DADman software, firmware updates, and proper function of MTRX II.

6 Click the link to download the installer for the latest version of DADman software for your operating system (macOS or Windows). 
DADman software is required to use MTRX II with Pro Tools.

Pro Tools | MTRX II Chassis and Expansion Cards
Pro Tools | MTRX II is a modular unit with standard digital I/O and processing built-in. It also provides eight expansion card slots for 
optional analog and digital I/O, and processing cards. All eight slots can be used with any combination of expansion cards.

MTRX II has a dedicated slot for an optional Dual MADI I/O mini-module (MADI). The MTRX Dual MADI I/O module uses “Small 
form-factor pluggable” (SFP) transceiver modules, which provide 2 x 64 MADI channels (optical or coaxial).

The MTRX II has a dedicated slot for an optional Thunderbolt 3 module with 2 USB-C Thunderbolt 3 ports for I/O connectivity between 
your computer and MTRX Studio.

Rack Mounting MTRX II
If you install MTRX II into a 19-inch rack, be sure to leave plenty of room for ventilation. 

MTRX II is fitted with two ultra-quiet fans to ensure optimum operating temperature. The fans are temperature-controlled, so the rota-
tion speed, and thereby noise, is dependent on the temperature inside the MTRX II. The fans should be hardly audible during normal 
operation, assuming MTRX II is correctly installed.

For information on installing and configuring DADman, see Installing and Configuring DADman Software

For information on installing optional expansion cards, refer to Installing MTRX Option Cards

For information on installing the optional MTRX MADI module, see Installing a MTRX MADI Module.

For information on installing and configuring the optional Thunderbolt 3 card, see Installing Expansion Cards.
Chapter 2: Installation and Registration

9

https://www.avid.com/register


The optimal air flow is from the vents in the front of the unit to the rear holes in the rear and top plate. When the unit is installed, con-
siderations have to be made to ensure proper air circulation from the bottom to the rear. It is recommended that you leave one rack unit 
of space free under unit, and do not block the back and top panel vent holes. The speed of the two low-noise fans will increase automat-
ically to keep the internal temperature low if there is insufficient airflow. A temperature alarm appears in the front panel display if the 
internal temperature exceeds 60º C / 140º F.

Connecting Cables
Once you have installed MTRX II in a rack (optional), you are ready to start connecting cables.

Connect Power
Connect the included IEC cable to MTRX II. Then connect the cable to a grounded AC power outlet. It is recommended that you connect 
to a grounded power switch or power conditioner. 

Connect Ethernet
Connect the MTRX II directly to your computer or to your computer’s network using a GigaBit Ethernet cable (not included) (see Net-
work Configuration). Ethernet is used to communicate with DADman and a Dante Network. Note that when using the optional Thun-
derbolt 3 module, only a Thunderbolt 3 cable connection is required.

Connect DigiLink
Connect one or two DigiLink Mini cables (not included) to the DigiLink Mini ports on MTRX II. Then connect the other end of these 
cables to an HDX card, or an HD Native card or HD Native Thunderbolt box. See Connecting Pro Tools | MTRX II to a 
Pro Tools | HDX or HD Native System Note that when using the optional Thunderbolt 3 module, only a Thunderbolt 3 cable connection 
is required.

Connect Thunderbolt 3 (Optional)
If you have installed the optional Thunderbolt 3 module, connect one end of a Thunderbolt 3 compatible cable to an available port on 
the MTRX II Thunderbolt 3 port to a Thunderbolt 3–compatible port on your computer. In addition to audio I/O, Thunderbolt 3 is used 
to communicate with DADman software, so you can use the Thunderbolt 3 module with any tier of Pro Tools without DigiLink or Ether-
net connections.

Connect Clock Sync
If you are installing Pro Tools | MTRX II in a system with multiple audio interfaces (such as HD I/O) and/or a synchronization peripheral 
(such as SYNC X), make the appropriate Word Clock or Video Reference cable connections using shielded BNC cables (not included).

Connect Audio
Make sure that your sound system is powered off. Make the appropriate analog and digital audio cable connections for your system.

Refer to the mechanical specifications section for more details regarding installation.

In order to meet EMC requirements and in order to obtain the highest performance of MTRX II, use high-quality, properly shielded 
cables for all external connections when installing MTRX II. For the power connection, a normal unshielded power cable with a 
proper protective earth conductor can be used.

To orient yourself with MTRX II back panel connections, see Pro Tools | MTRX II Front and Back Panels

For more information, see Installing Thunderbolt 3 Option Module.
Chapter 2: Installation and Registration
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Network Configuration
Pro Tools | MTRX II has two network ports on the back designated Net 1 and Net 2. The primary function of these network ports is to 
provide a connection between DADman software on a computer and MTRX II so it can be configured and controlled. The two network 
ports normally operate as a small network switch so it is critical to only use one of the two network ports. Net 1 is recommend. The de-
fault network setting for the network port is DHCP, so MTRX II will receive an IP address from a DHCP server (if one is present on 
the network). If required, it is possible to change the IP address of the MTRX II to a fixed IP address from the DADman control software.

The network ports are also used for control and IP audio streaming with integrated 256-channel Dante. Dante has its own IP address, 
which is set to DHCP-assigned by default. This can be changed to a fixed IP address using either the DADman software or Dante Con-
troller. As mentioned earlier, the two network ports operate as a small network switch. However, when MTRX II is configured for use 
with built-in Dante it is possible to set the Dante interface to Redundant mode. In this configuration, use Net 1 for DADman control of 
MTRX II and the primary Dante connection, and use Net 2 for the redundant/secondary Dante connection.

The factory default setting of the IP address of the controller port of the MTRX II is 10.0.7.20. The IP address can be changed manually 
using DADman or it can be set to be automatically assigned by a DHCP server/router in the network. If needed, MTRX II can be set in 
recovery mode with the fixed factory defined IP address (10.0.7.20) and IP discovery using DHCP.

For a more detailed description of MTRX II network functionality, configuration, and behavior, see Network Fundamentals.
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Chapter 3: Connecting Pro Tools | MTRX II to a 
Pro Tools | HDX or HD Native System

Pro Tools | MTRX II can be configured for a wide variety of audio production workflows with either Pro Tools | HDX or 
HD Native hardware.

HDX With HDX hardware, MTRX is connected to an HDX card using one or two DigiLink Mini cables (not included). You can 
connect additional HD audio interfaces to your system using the second DigiLink Mini port on the back of MTRX, the second 
DigiLink Mini Port on the HDX card, or by using additional HDX cards. See Connecting Pro Tools | MTRX II to Pro Tools | HDX. 

HD Native With HD Native hardware, MTRX is connected to the HD Native card using one or two DigiLink Mini cables (not in-
cluded). You can connect additional HD audio interfaces to your system using the second DigiLink Mini port on the back of MTRX 
or the second DigiLink Mini Port on the HD Native card or HD Native Thunderbolt device. See Connecting Pro Tools | MTRX II 
to Pro Tools | HD Native.

Connecting Pro Tools | MTRX II to the Network
Connect Pro Tools | MTRX II to your network using either CAT5e or CAT6 cables connected to one or both of the Ethernet ports 
on the back panel (see Network Configuration).

Depending on whether or not you have installed the optional Dante 64 module, and whether or not MTRX is set to Switch mode 
or Redundant mode, make the following Ethernet connections:

• DADman control: 

• Switch — Net 1 & 2

• Redundant — Net 1 only

• 256 channel built-in Dante:

• Switch — mirrored Dante Net 1 & 2

• Redundant — mirrored Dante Net 1 & 2

For more information about installing HDX cards, see the Pro Tools | HDX Card Installation Guide.

For more information about installing the HD Native card, see the Pro Tools | HD Native Installation Guide.

For more information about installing HD Native Thunderbolt, see the Pro Tools | HD Native Thunderbolt Installation Guide.
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Connecting Pro Tools | MTRX II to Pro Tools | HDX
You can use up to 64 channels of analog and digital I/O with MTRX II connected to an HDX card using two DigiLink Mini cables (not 
included).

To connect MTRX to an HDX card:

1 Required: Connect the first MTRX II DigiLink Mini Port to DigiLink Mini Port 1 on the HDX card using a DigiLink Mini cable (not 
included).

2 Optional: Connect the second MTRX II DigiLink Mini Port to DigiLink Mini Port 2 on the HDX card using a second DigiLink Mini 
cable (not included).

+

Figure 1. MTRX II connected to both DigiLink Mini ports on an HDX card
Chapter 3: Connecting Pro Tools | MTRX II to a Pro Tools | HDX or HD Native System
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MTRX II with a MADI I/O in an HDX 2 System
The following shows MTRX II and MADI I/O with Word Clock connections and DigiLink Mini connections with two HDX cards.

Figure 2. HDX 2 system: MTRX II connected to both DigiLink Mini ports on HDX card 1, MADI I/O connected to both DigiLink Mini ports on HDX 
card 2, Word Clock connection between MTRX II and MADI I/O
Chapter 3: Connecting Pro Tools | MTRX II to a Pro Tools | HDX or HD Native System
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Connecting Pro Tools | MTRX II to Pro Tools | HD Native
You can use up to 64 channels of analog and digital I/O with MTRX II connected to an HD Native card or HD Native Thunderbolt using 
two DigiLink Mini cables (not included).

To connect MTRX II to an HD Native card or HD Native Thunderbolt:

1 Required: Connect the first MTRX II DigiLink Mini Port to DigiLink Mini Port 1 on the HD Native card or HD Native Thunderbolt 
using a DigiLink Mini cable (not included).

2 Optional: Connect the second MTRX II DigiLink Mini Port to DigiLink Mini Port 2 on the HD Native card or HD Native Thunder-
bolt using a second DigiLink Mini cable (not included).

Synchronization
If you are using two or more audio interfaces or a synchronization peripheral, each device must be connected to a clock source to main-
tain proper synchronization among the devices. MTRX II provides Internal clock, and can also clock to Word Clock/video black burst 
(VBB) using BNC connectors, Dante sync, or digital inputs. Use Internal if MTRX II is your master clock. Use Word Clock with 
Pro Tools HD audio interfaces or a synchronization peripheral (such as HD I/O or HD MADI, and Sync X or SYNC HD).

Figure 3. MTRX II connected to both DigiLink Mini ports on an HD Native card

To orient yourself with MTRX II back panel connections, see Pro Tools | MTRX II Front and Back Panels.
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Chapter 4: Pro Tools | MTRX II Front and Back Panels

Pro Tools | MTRX II is controlled over Ethernet by DADman software on your computer. Some controls are also available on the 
front panel of the unit. Two rows of LED indicators show the AD and DA signal level, and an LCD display that shows various set-
tings of the MTRX II. The four front panel buttons let you access the settings shown in the display.

Pro Tools | MTRX II Front Panel

1 Internal sync indicator. Green LEDs shows internal or external sync source.

2 External sync source two-color indicator. Green LEDs shows external sync source OK, red LED indicate that no or bad 
sync signal.

3 On/Standby button. Note that the unit automatically returns to the last power state (on or standby) if it is power cycled via the 
mains power.

4 Error indicator, Red LED. Indication in related to hardware performance and can be temperature overload, Fan error, DAD I/O 
card failure or general internal boot error. A more specific error indication will be visible in DADman.

Pro Tools | MTRX II Back Panel

Pro Tools | MTRX II front panel

Pro Tools | MTRX II back panel

1 2

3 4

1

2

4

3

5

6

7

8 9
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1 Main power supply.

2 Reconfig button. For more information, see Recovery Mode.

3 RJ45 Ethernet ports 1 and 2 for Control and Dante Audio IP. Connectors can be set in switched or redundant mode for Dante. In re-
dundant mode the control network must be connected to port 1.

4 Mini-module slot for optional dual MADI I/O mini module optical or coaxial SFP modules.

5 Slot for optional 256 channel (2 ports, 256 channel with either port) Thunderbolt 3 module.

6 Word Clock or Video Black Burst synchronization input (configurable), BNC connector, and Word Clock output.

7 MADI I/O BNC connectors.

8 DigiLink Mini port 1 and 2 for Pro Tools | HDX or HD Native, or another I/O.

9 Analog and digital I/O expansion cards are installed into slots along the back of the unit in card slots 1–8 (right to left). All eight slots 
can be can be used at once in any combination or order.

Digital I/O Connections

MTRX II Dual MADI I/O Expansion Card

The MTRX II Dual MADI I/O expansion card can be installed with one or two “Small form-factor pluggable” (SFP) transceiver mod-
ules. The SFP modules are standard types which support coaxial as well as optical and interfaces with LED or Laser diodes, and various 
wavelengths and fiber types. Each SFP module has a receiver and a transmitter part, and can be used for MADI audio I/O. The right part 
of the SFP connector is the receiver and the left part is the transmitter. Note that only optical MADI connections support MTRX II Ho-
tlink functionality.

Ethernet, RJ45 Connector, Gigabit

Pin 1 BI_DA+

Pin 2 BI_DA–

Pin 3 BI_DB+

Pin 4 BI_DC+

Pin 5 BI_DC–

Pin 6 BI_DB–

Pin 7 BI_DD+

Pin 8 BI_DD–

For information on installing expansion cards, see Installing MTRX Option Cards. 

Optical wavelengths of 850nm and 1300nm are commonly used for multi-mode MADI cards. 1300nm uses 100BASE-FX cable and 
allows for cable runs as far as 6,600 feet. 850nm is a lower cost alternative that uses 100BASE-SX cable, due to the use of short wave-
length optics (which are significantly less expensive than the long wavelength options used in 100BASE-FX), with maximum cable 
runs up to approximately 1,000 feet.

Optical I/O
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Thunderbolt 3 Option Card
Two USB-C type connectors for connecting Thunderbolt 3/USB-C. The two connectors 1 and 2 have the same functionality one can be 
connected to the computer and the other to an additional audio interface for expansion or to a standard USB-C peripheral device 
(non-audio functionality).

Coaxial BNC for MADI
Coaxial BNC connector for input and output of MADI signals via 75Ohm Coax cables.

Coaxial BNC for Sync
Coaxial BNC connector for Clock input synchronization and Word Clock output. The input clock format can be Word Clock or Video 
Black Burst (VBB).

A high-speed Thunderbolt 3 cable should be used for interconnection. The cable should be Thunderbolt 3 20 Gbps or 40 Gbps USB-C 
cable and preferably Intel Certified.
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Analog I/O Connections

Analog I/O 25-pin Female D-sub Connectors
There are four types of optional analog cards for MTRX II:

Pro Tools | MTRX II 8 Line Pristine AD card 8-channel Line AD Card.

Pro Tools | MTRX II 2 Mic/Line Pristine AD card 2-channel Mic/Line AD Card.

Pro Tools | MTRX II 8 Mic/Line Pristine AD card 8-channel Mic/Line AD Card.

Pro Tools | MTRX II Pristine 8 DA card 8-channel Line DA Card.

These are interfaced using 25-pin D-sub connectors on the card. This connector type is used for both the analog input card and the analog 
output card.

Connections Channels 1–8

The connections for the 25-pin D-sub connector are listed in the table below. The pinning is according to the proprietary standard by 
Tascam.

Pin no Func. Pin no Func.

1 AIN/OUT 8 + 14 AIN/OUT 8 –

2 GND 15 AIN/OUT 7 +

3 AIN/OUT 7 – 16 GND

4 AIN/OUT 6 + 17 AIN/OUT 6 –

5 GND 18 AIN/OUT 5 +

6 DOUT 2/6 + 19 GND

7 AIN/OUT 4 + 20 AIN/OUT 4 –

8 GND 21 AIN/OUT 3 +

9 AIN/OUT 3 – 22 GND
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Example System Configurations

10 AIN/OUT 2 + 23 AIN/OUT 2 –

11 GND 24 AIN/OUT 1 +

12 AIN/OUT 1 – 25 GND

13 N.C.

Pin no Func. Pin no Func.
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Chapter 5: Installing and Configuring DADman Software

Installing DADman Software
Pro Tools | MTRX II is controlled over a network connection by DADman software on your computer. Your computer and all 
MTRX II units must be connected on the same subnet.

To install DADman Software:

1 Download the DADman Software installer for your operating system (macOS or Windows) from your Avid Master Account. 

2 Once the download is complete, launch the installer and follow the on-screen instructions to complete the installation.

3 If desired, create a shortcut for DADman on the Desktop, or in the Dock (Mac) or in the Start menu (Windows).

4 Launch DADman.

5 Choose Settings > Device List.

6 Click Refresh to discover the MTRX II on the network.

7 Right-click the MTRX II and choose Network Settings.

Device List dialog
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8 Configure the Network Settings accordingly (see Assigning the IP Address for your Computer and Pro Tools | MTRX II).

Assigning the IP Address for your Computer and Pro Tools | MTRX II
If using multiple MTRX II units (MTRX II and MTRX units can be used in conjunction on the same network), connect them one at a 
time to complete the network setup. If using a single MTRX II, ensure it is connected to the network and proceed. You have the option 
of using fixed IP addresses or IP addresses assigned via DHCP. If using DHCP, it is recommended that MTRX II be connected to a 
Router rather than rely on a self assigned 169.254 IP address.

Automatic IP address
You must have a network with a DHCP server to allocate the IP addresses.

To use an automatic IP address:

1 Configure your computer IP address to DHCP using the Mac System Preferences or the Windows Control Panel.

2 Choose Settings > Device List, then right-click the MTRX II and choose Network Settings.

3 Configure each MTRX II in turn to use DCHP.

4 When you are done, you can connect more than one MTRX II to the network (MTRX II and MTRX units can be used in conjunction 
on the same network), and they will all appear in the DADman Device List.

Network Settings

When using IP Audio Dante with one or more MTRX units and EUCON peripherals (such as S1, S3, Dock, S4, or S6), use a dedicated 
Network Interface for IP Audio Dante and connect all other network devices to a separate Network Interface (for MTRX/DADman, 
EUCON, local network, internet, and so on). Using separate Network Interfaces is especially important when streaming audio over 
Dante.

In order for MTRX to function properly, the router must be correctly configured in DADman software.
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Fixed IP Address
You must have a preferred range of IP addresses, and a network mask for the computer network and the connected MTRX units.

To use a fixed IP address:

1 Configure your computer IP address and network mask using the Mac System Preferences or the Windows Control Panel to 10.0.7.25 
| 255.255.255.0 for example.

2 Choose Settings > Device List, then right-click the MTRX II and choose Network Settings.

3 Configure each MTRX unit in turn with a unique IP address and the preferred network mask on the same subnet as the computer, for 
example 10.0.7.21 | 255.255.255.0. In this window you can also configure the IP audio network settings.

4 When you are done you can connect more than one MTRX II (or MTRX) to the network, and each one appears in the DADman 
Device List.

Updating Pro Tools | MTRX II Firmware

To update your Pro Tools | MTRX II firmware:

1 Visit avid.com and log in to your Avid Master Account.

2 Download the latest MTRX II firmware from the My Products page of your Avid Master Account.

3 Launch DADman and choose Settings > Device List (make sure your MTRX II unit is connected and ready).

4 Right-click on the MTRX II unit in the Device List that you want to upgrade.

5 Choose Firmware Update.

6 In the resulting dialog, click File.

7 Navigate to and select the MTRX II firmware file that you downloaded from your Avid Master Account.

8 When prompted, confirm that you want to update the firmware for the MTRX II unit.

9 A progress dialog appears. The update process takes a few minutes.

10 Once the firmware update is complete, you are prompted to restart the unit.

Save and back up your MTRX II Configuration files (.dms) and Monitor Profile files (.dmprof) before updating MTRX II firmware. 
For more information, see ... .
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Chapter 6: DADman Software

Use DADman software on an Avid-qualified computer (macOS or Windows) to configure and control one or more MTRX II and/or 
Pro Tools | MTRX II Studio units over Ethernet. DADman is a channel strip–oriented, software control interface for MTRX II and 
MTRX Studio units on your system’s network. It shows all connected units in the Device List from left to right. Connected units 
are shown in sequence according to the unit ID number. Each unit has a colored border surrounding the functions of the unit.

The settings of a MTRX II are always stored in the unit itself as well as saved on your computer (.dms file). DADman shows the 
current status of all settings on each connected MTRX II or MTRX Studio. DADman lets you save Configuration files on your 
computer to backup and store all MTRX II and MTRX Studio settings and network configurations. Settings include naming, unit 
preferences, and routing, but do not include Monitor Profile settings (for more information on Monitor Profiles, see Monitor Pro-
files).

DADman can be set to automatically load the last used settings on launch. If no Configuration file is loaded on launch, connections 
to MTRX II and MTRX Studio units in the Device List must be reestablished after launch.

DADman can also be controlled remotely from various external sources. DADman can be connected by MIDI to Pro Tools so that 
MTRX II units can emulate Pro Tools | PRE hardware. Configure the PRE settings in Pro Tools to control MTRX II pre amps from 
Pro Tools software. For more information, see Controlling MTRX II Preamps from Pro Tools (Mac Only).

DADman Menus
Use the DADman File and Settings menus to Save and Load Configuration files (.dms), and to access Settings on Windows. On 
Mac, access Preferences from the DADman menu.

Saving and Opening Configuration Files
When you have set up DADman as you like, you can save the configuration so it can be re-loaded later if necessary. A configuration 
file (.dms) contains channel naming, routing, and unit preferences.

To save a Configuration file (.dms) in DADman:

1 Choose File > Save.

2 In the Save dialog, navigate to where you want to save the file and name the file (.dms). 

3 Click Save.

To open a Configuration file in DADman:

1 Choose File > Open.

2 In the Open dialog, navigate to and select the Configuration file that you want to load.

3 Click Open.

Clone Settings
DADman lets you clone the settings from one unit to another like unit (for example from a MTRX II to another MTRX II).

To clone the settings from one unit to another:

1 Ensure that both units are connected and recognized on the network.

2 Choose File > Clone Settings.

For information on DADman Monitor Profiles, see Monitor Profiles.
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3 In the resulting Clone Settings dialog, do the following:

• Select the target unit.

• Select either Get Settings from a Connected Unit and select the source unit, or Get Settings from a Settings File and open the 
settings file.

4 Click Clone.

Preferences and Options

To set Preferences (Mac) or Options (Windows) for DADman:

1 Choose DADman > Preferences (Mac) or Settings > Options (Windows).

Clone Settings dialog

Options dialog (Windows)
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2 Configure the MTRX II Preferences (Mac) or Options (Windows) as desired:

GUI Layout Select a color scheme for DADman.

Open last setting file at startup When enabled, DADman automatically loads the latest configuration file and downloads it to the 
MTRX II. This provides a well-defined starting point in case other users have changed the configuration of the MTRX II. However, as 
multiple users can operate the MTRX II simultaneously, be careful to not disturb the work of other MTRX II users on the network.

Open last profile at startup When enabled, DADman automatically loads the latest profile and downloads it to the MTRX II. This pro-
vides a well-defined starting point in case other users have changed the configuration of the MTRX II. However, as multiple users can 
operate the MTRX II simultaneously, be careful to not disturb the work of other MTRX II users on the network.

When DADman Closes Select what DADman should do with the setting file and the profile when you close DADman.

3 Click OK.

DADman Window
The DADman window is separated into the five sections: AD, DA, Monitoring (if configured), Connections, and Configuration. Each 
subsection can be shown or hidden by clicking on the corresponding button in the leftmost column.

Note that the order from left to right in which DADman shows the units is defined by the Unit ID number stored in each unit. The ID 
number for any unit can be changed by editing the Unit ID field in the Device List window (Settings > Device List). You can name each 
MTRX II unit separately in the DADman window (just to the right of the Unit ID number at the top of each section). This name is stored 
in the unit, and can be seen in the MTRX II display. Names can also be assigned for each analog input and output channel. However, 
these channel names are only stored in MTRX II Configuration files, not in the MTRX II unit itself.

DADman Window
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AD Section
The AD section controls any Mic/Line AD and Line AD cards in the MTRX II. If there are no AD cards in the MTRX II, the AD section 
for that MTRX II is empty.

The sliders for MIC gain can be adjusted with the mouse, the mouse scroll wheel, or with the Up and Down Arrows on your computer 
keyboard. Note that using the mouse adjusts the gain by 0.1 dB increments, but the Up and Down Arrow keys adjusts the gain by 1.0 dB 
increments.

DA Section
The DA section controls any DA cards in the MTRX II. If there are no DA cards in the MTRX II, the DA section for that MTRX II is 
empty.

AD section

Command-click (Mac) or Control-click (Windows) any fader to set it to 0.

DA section
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Monitoring Section
The Monitor (Mon) section is available when the Enable monitor option is selected in the Monitor Profile Configuration Settings win-
dow (Settings > Monitor Profile). This lets you monitor defined sources and route them to defined outputs, which is configured in the 
Monitor Profile Configuration Settings window (for more information, see Monitor Profiles). The Mon section also provides controls 
for Talkback parameters, EQ Filter options, and signal delay amounts (for more information, see SPQ Processing).

Connections Section
The Connections section provides a cross-point matrix for configuring the routing of all available analog and digital inputs and outputs 
for each unit in on the network. In addition to the built-in digital I/O and DigiLink connections to and from Pro Tools, all I/O expansion 
cards installed in the unit are also shown here. You can route any input channel (mono) to one or more output channels within the same 
unit. All routing configurations are internal to each individual unit, so you cannot route the inputs from one MTRX II unit to the outputs 
of a second MTRX II unit on the network. To accomplish this, route an output from one MTRX II to the inputs of another MTRX II.

The Connections section includes of an Overview matrix on the left and a Detailed matrix to the right, which appears when you select 
a cross point between an Input Source and an Output Destination in the Overview matrix. 

The left side of the Overview matrix shows all available inputs (sources) for the unit. Available outputs are displayed vertically across 
the top of the Overview matrix. For example, the picture below shows the cross-point matrix for an installed 8-channel analog to digital 
expansion card (AD on the left) where each input channel is routed to Pro Tools input channels 1–8 (DigiLink main – 1 on top). 

Mon section

Connections section: DADman Matrix
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Along the top of the Detailed matrix view, there is a status indicator for each output channel:

Blue A blue circle is displayed at the top of the column if an input channel is already routed to an output channel.

Dark Blue The circle is dark blue if an input channel that is shown in the current Detailed matrix (because the source is selected in the 
Overview matrix) is already routed to the output channel. 

Light Blue The circle is light blue if an input channel from another source, not shown in the current Detailed matrix (because it is not 
selected in the Overview matrix) is already routed to the output. 

In the left side of the Detailed matrix, there is a status indicator for each input channel:

Green On a digital input, green indicates that there is a valid input and carrier. It does not indicate whether there is an audio signal pres-
ent on the channel. For an analog channel, it indicates that the expansion card is present.

Yellow Indicates lost synchronization or mismatched sample rates.

Red Indicates an error with the interface, such as no input signal.

To route individual input channels to one or more output channels:

1 In the Overview matrix, click in the junction of an input source (Inputs are listed in the rows on the left)—such as an installed analog 
input expansion card (AD) or one of the built-in digital input ports, like AES/EBU, or Pro Tools output channels (DigiLink)—and 
the output destination you want (Outputs are listed in the columns on the top)—such as an installed analog output expansion card 
(DA) or one of the built-in digital output ports, like MADI coax, or Pro Tools input channels (DigiLink). The junction turns blue and 
the Detailed channel to channel routing matrix appears to the right.

2 In the Detailed matrix, click in the junction of the input channel for the selected source (each input channel is listed in the rows on 
the left) and the output channel to which you want route the signal (each output channel is listed in the columns on top). A blue circle 
indicates that the input channel (row) is routed to an output channel (columns).

3 To route a single input channel to multiple output channels, click in each column (outputs) in the same row (input) to make each con-
nection.

To disconnect an input and output:

 Click any crosspoint connection (blue) to disconnect it.

Configuration Section
The Configuration section is divided into subsections, such as Sync, Dante, DigiLink, Madi, and SDI.

Shift-click to connect consecutive pairs of input channels to consecutive pairs of output channels.

Command-click (Mac) or Control-click (Windows) to connect all input channels in order to consecutive output channels in order. The 
connection points are made diagonally from the top left down and to the right.

General section
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Dante

Sample Rate (Main or Card)

Follow Dante is set to the sample rate of MTRX II.

Free  Dante sample rate is not set by MTRX II. The sample rate must be set by the Dante Controller.

Latency (Main or Card)

Value Sets the Dante network latency from 250 to 21,333 microseconds (21,333 milliseconds).

Preferred Master (Main or Card)

Yes Dante is set to the preferred master of the Dante clock. The Dante network is synchronized to MTRX II Dante.

No  Dante clocks to the Dante network.

SRC Enable (Card Only)

On Enables the sample rate converter.

Off Disables the sample rate converter.

Any installed Dante expansion card supports Dante Domain Manager (DDM). When the card is entered into a domain, the control of 
the Dante card is disabled from DADman software. However, the actual status of the setting are still visible.

Dante configuration options (Main shown)

Dante configuration options (Card shown)
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Synchronization Combinations

The Dante node can operate as a clock master, synchronizing the Dante network, or be externally synchronized from the Dante network. 
When the Sample Rate Converter (SRC) is not enabled, it means that the network and MTRX II have to be in sync, so when the Dante 
network is the sync master, MTRX II must follow the network clock. In this scenario, the sample rate must be the same as the Dante 
Stream and the MTRX II unit. If MTRX II is the master the unit, it provides the clock for the Dante network.

If SRC is enabled, there are two options with regard to functionality. The Dante Network and MTRX II are synchronized and running 
on the same clock, but the sample frequency of audio on the Dante network is different from the sample rate on MTRX II: the Dante Net-
work and MTRX II are not synchronized and running on different clocks. The sample rate can be the same or different on the Dante net-
work and on MTRX II. However, in this case, the sample rate and the clock sync setting of the Dante card have to be done using the 
Dante controller.

Synchronization

The Synchronization pane in the General sections lets you set the following MTRX II parameters: Source, Sampling (sample rate), 
Adapt to, Word Clock Out, and Sync term (synchronization termination). The following table shows which settings are available. 
Please note that DADman will only show the settings that are relevant in the given configuration.

Parameter Options Description

Sync Source Internal
Word clock
Video
MADI Coax
MADI Optical 1–2
Dante IP

This determines the clock source of the MTRX II

Sync Out Word clock
Word clock, base

This parameter sets whether the Word Clock output should only follow the base 
sample rate (44.1 kHz / 48 kHz) or follow the actual sample rate (44.1k / 48k / 
88.2k / 96k / 176.4k / 192k).

Sync term. High Z
75 ohm

This parameter sets whether the Word Clock input is terminated internally in the 
MTRX II with 75 ohm, or left unterminated. It is strongly recommended that the 
Word Clock input is terminated in 75 ohm for optimum performance.

Digi Dly (samples) Minimum, 3–31 Sets this internal processing delay. It is strongly recommend that this always be 
set to “Minimum.” When set to “Minimum,” MTRX II automatically determines 
best value. Setting it to any other value can result in loss of audio or other unde-
sired artifacts. However, in larger systems with multiple MTRX II (and MTRX) 
units, you may want to set it to a higher value than “Minimum.” This is only the 
case if mutliple MTRX II and/or MTRX units are interconnected using the 
“HotLink” interface.

Sampling 44.1 kHz, 48 kHz
88.2 kHz, 96 kHz
176.4 kHz, 192 kHz
DSD 64 fs, DSD 128 fs
DXD, 384 kHz

This determines the sample rate of the MTRX II if the Adapt to setting is set to 
Internal. If the Adapt to setting is set to any of the digital inputs, only the actual 
sample rate will be shown.

Adapt to Internal
DigiLink 1–2
DigiLink Card (if installed)
MADI Coax
MADI Opt. 1–2
Dante IP
Thunderbolt (if installed)

The sample rate of the MTRX II can either be set manually by selecting Internal, 
or it can follow any of the digital inputs. For example, if it is set to Pro Tools 1, the 
sample rate will automatically follow the sample rate in your Pro Tools project. 
The list of available Adapt to sources are sourced from the integrated digital 
inputs; internal, Digilink 1-2, MADI Coax, or Dante IP. You can also adapt to any 
digital option cards installed such as: DigiLink card, MADI Opt 1–2, MADI card, 
AES card, Dante card, and so on.
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DigiLink

MTRX II can be configured as either two Primary audio interfaces (Pri/Pri) or as a Primary audio interface and an Expansion audio in-
terface (Pri/Exp). While these can be configured to emulate HD IO or MADI I/O audio interfaces (each with up 16 channels per inter-
face), it is recommended that you select MTRX 32x32 with Pro Tools | HDX and HD Native systems.

To setup the DigiLink configuration:

 Click the DigiLink button and select either Pri/Exp (when using a single DigiLink Mini port to connect to your HDX or HD Native 
hardware and the other DigiLink port to connect to an expansion Pro Tools audio interface) or Pri/Pri (when using a both DigiLink 
Mini ports to connect to your HDX or HD Native hardware) from the DigiLink mode selector.

To change the audio interface emulation:

 Click the DigiLink button and select MTRX 32x32 from the Port 1 emul selector. If DigiLink mode is set to Pri/Pri, also select 
MTRX 32x32 from the Port 2 emul selector.

MADI Coax Interface

The built-in MADI Coax interface can be configured for compatibility with different implementations of MADI.

Frame rate Can be set to Legacy or High, but only if the sample rate is higher than 48 kHz. If the sample rate is 44.1 kHz or 48 kHz, 
the Frame rate is always Legacy. In Legacy mode, the MADI Frame length is maintained and adjacent channels are “merged” into one 
channel. In High mode, the MADI Frame length is reduced rate and consequently the Frame rate is increased. Because of this difference, 
High mode has lower latency than Legacy mode. Please note that some third-party MADI products may not support High mode.

Frame size Can be set to Normal or Extended. Normal mode supports up to 56 channels whereas Extended mode supports up to 64 
channels.

Ch. status Can be set to Default or Transparent. This setting is only relevant when routing incoming AES/EBU or MADI channels to 
a MADI output. In Default mode, the MADI Channel status bits are 
defined by the MTRX II, whereas in Transparent mode the channel status bits from the relevant source (AES/EBU or MADI) are trans-
ferred to the outgoing MADI signal. In most cases it is best to leave it in 
Default mode.

Input rate Can be set to Auto or As AD. In Auto mode, the MTRX II determines the sample rate of the incoming MADI signal. In As 
AD mode, the MTRX II assumes that the incoming MADI has the same sample rate as the MTRX II. It is usually recommend to leave 
this set to Auto. However, there may occasionally be compatibility issues with third-party products, in which case, setting it to As AD 
may solve any problems.

DigiLink configuration options

MADI Coax configuration options
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Optical 1 / Optical 2 Interface

When a MTRX II Dual MADI IO option card or MTRX II MADI option card is installed, the Optical MADI interfaces can be config-
ured for compatibility with different MADI implementations.

Mode Can be set to Disabled, MADI, or NTP HotLink. The optical interface board can be fitted with one or two SFP optical interface 
modules. It is recommended that you set the optical interface to Disabled if no SFP optical module is installed. Select MADI to use the 
interface with a MADI signal.

Frame rate Can be set to Legacy or High, but only if the sample rate is higher than 48 kHz. If the sample rate is 44.1 kHz or 48 kHz, 
the Frame rate is always Legacy. In Legacy mode, the MADI Frame length is maintained and adjacent channels are “merged” into one 
channel. In High mode, the MADI Frame length is reduced rate and consequently the Frame rate is increased. Because of this difference, 
High mode has lower latency than Legacy mode. Please note that some third-party MADI products may not support High mode.

Frame size Can be set to Normal or Extended. Normal mode supports up to 56 channels whereas Extended mode supports up to 64 
channels.

Ch. status Can be set to Default or Transparent. This setting is only relevant when routing incoming AES/EBU or MADI channels to 
a MADI output. In Default mode, the MADI Channel status bits are 
defined by the MTRX II, whereas in Transparent mode the channel status bits from the relevant source (AES/EBU or MADI) are trans-
ferred to the outgoing MADI signal. In most cases it is best to leave it in 
Default mode.

Input rate Can be set to Auto or As AD. In Auto mode, the MTRX II determines the sample rate of the incoming MADI signal. In As 
AD mode, the MTRX II assumes that the incoming MADI has the same sample rate as the MTRX II. It is usually recommend to leave 
this set to Auto. However, there may occasionally be compatibility issues with third-party products, in which case, setting it to As AD 
may solve any problems.

SDI

The SDI tab is only present if an SDI expansion card is installed in MTRX II. The SDI expansion card is audio embedder/deembedder 
card that has two sets of embedders and deembedders compliant with the relevant SMPTE standards for SD, HD and 3G video SDI sig-
nals, and audio embedding and deembedding.

Hotlink supports 128 channels at 48 kHz. MTRX II can support up to 10 Hotlink connections with a MADI Expansion card installed in 
each of the 8 Expansion card slots and a Dual MADI IO module installed in the mini-module slot (which supports 2 Hotlink connections). 
This is useful in broadcast audio workflows. Hotlink is only supported at the sample rate of 48 kHz.

SDI configuration options
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SDI Embedder Ports 1 and 2

Embedder Enable or disable. When disabled the SDI output is transparent from the input.

SRC Sample Rate Defines the sample rate of the embedded audio for the complete SDI frame.

Group 1–4 Modes Insert SRC, Remove, Sync, or Async.

Port Name Displays the port name.

SDI Deembedder Ports 1 and 2

SRC Group 1–4 Enable or disable.
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Chapter 7: Monitor Profiles

A monitor profile is a control room or cue system using the available analog and digital I/O MTRX II. You can add sources, out-
puts, fold downs, and meters to define a monitor within DADman. A single monitor can contain multiple sources (inputs) and out-
put sets, including stereo, surround, and expanded Atmos configurations using analog or digital I/O. You can efficiently switch be-
tween near-field stereo, 5.1 or 7.1 surround, as well as Atmos speaker configurations using a EUCON-compatible control surface 
(such as S1, S6, or the Avid Control app).

Monitor Profile Files
To use the monitoring and cue functionality of MTRX II, you need to create or import a Monitor Profile (.dmprof files).

Monitor Profile Configuration Window
The Monitor Profile Configuration window lets you create and edit monitor profiles for MTRX II. It is organized into multiple 
pages: Groups, Fold down, Group formats, Mom, and MTRX II. Click the corresponding tab to view each page.

To open the Monitor Profile Configuration window:

 Choose Settings > Monitor Profile.

Monitor Profile Configuration window
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To enable monitor profiles:

1 Choose Settings > Monitor Profile.

2 Select the unit you want to use for monitoring.

3 Select Enable monitor.

Opening, Saving, and Closing Monitor Profile Settings
Monitor Profiles can be saved and opened from the file menu. Monitor Profile files (.dmprof) store all monitor settings, EQ, and format 
configurations that are loaded and active in DADman. When a profile is loaded all Monitor settings are restored. You can set the Pref-
erences (Mac) or Options (Windows) to automatically load the last saved monitor profile when DADman opens.

To open a monitor profile:

1 Choose File > Open Profile.

2 Navigate to the profile (.dmprof) you want to open and select it.

3 Click Open.

When opening a monitor profile created on a different unit, you may encounter a “File Load Error.” This error occurs because the mon-
itor profile tries to match the serial number of the unit on which it was created. You can load the monitor profile and safely dismiss this 
error by clicking Retry once and then Cancel. 

To avoid this error in the future, Save the monitor profile under a new name and it will use the your device’s serial number.

1 Choose Settings > Monitor Profile.

2 If necessary, click the Groups tab.

3 Select the unit you will use for monitoring.

4 Select Enable monitor.

5 Choose File > Save Profile As.

6 Replace the existing file or save your changes as a new monitor profile.

7 Click Save.

Note that a monitor profile assumes that the I/O resources loaded are available in the actual unit. If this is not the case, the I/O 
configurations are left blank and you will need to manually remap sources and outputs.

File Load Error dialog
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To save a monitor profile:

1 Choose File > Save Profile. 

If you are saving edits to an existing profile, your changes are saved to that file and you can ignore the following steps. If you saving a 
newly created profile, continue with the following steps.

2 In the resulting Save As dialog, type a name for the monitor profile.

3 Navigate to where you want to save the profile (.dmprof).

4 Click Save.

To save a monitor profile as a new file:

1 Choose File > Save Profile As.

2 In the resulting Save As dialog, type a name for the monitor profile.

3 Navigate to where you want to save the profile (.dmprof).

4 Click Save.

To close the current monitor profile:

 Choose File > Close Profile. 

DADman saves the profile and closes it.

Importing Monitor Profiles from Other MTRX and MTRX II Units

You can import a Monitor Profile (.dmprof) created by other MTRX or MTRX II units.

To import a Monitor Profile:

1 Choose File > Import Profile.

2 Navigate to and select the .dmprof file you want to import. 

3 From the Select Unit menu, select the MTRX device you want to use for monitoring. 

4 Select Enable monitor, then the Mon row in DADman will be populated with the new monitor profile.
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Importing Groups and Group Formats from a Monitor Profile
You can import Groups and Group formats from any monitor profile file (.dmprof) into the current monitor profile in DADman.

To import groups and group formats from a monitor profile:

1 Choose Settings > Monitor Profile.

2 In the Monitor Profile Configuration window, click the Input from profile button.

3 In the resulting Import Profile Settings window, click Open profile.

4 Navigate to the monitor profile you want, select it, and click Open.

Monitor Profile Configuration window
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All of the Groups and Group formats from the selected monitor profile are listed in the Import Profile Settings window.

5 In the left pane of the window, select any Groups that you want to import into the current monitor profile. In the right pane, select any 
Group formats that you want to import.

6 Click Import selected.

The selected Groups and Group formats are loaded into the current monitor profile.

Import Profile Settings window
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Groups Page
The Groups page of the Monitor Profile Configuration window lets you create and edit monitor and cue configurations for MTRX II. 
The Groups page consists of a left pane where you can add monitor and cue groups, and a right pane where you can make input and out-
put assignments. 

Groups Lists Talkback, Monitors and Cues, and their various attributes such as Outputs and Sources.

Mode Shows selected features of elements in the Groups column, such as the Monitor mode (Cue or Master) and channel widths for 
Outputs and Sources.

EUCON shows monitor control assignments for EUCON-compatible control surfaces (such as S1, S6, and Avid Control app).

The right pane is organized in four columns: Role, Channel, Label, and Trim. These are all attributes of whatever is selected in Groups 
column in the left pane, such as Outputs and Sources.

Role Displays the speaker assignments for each channel in the Monitor group, such as Left, Right, Center, or Lfe.

Channel Displays the input or output assignments for Monitor groups. Right-click to select routing assignments for each channel to any 
of the available analog or digital I/O, such as AD, DA, DigiLink, or Dante.

Label Click to type a label for the channel.

Trim Click to type a negative value to attenuate or a positive value to boost (in dB) the signal level for each channel.

Monitor Profile Configuration window, Groups page
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Talkback
Talkback is the first item in the Groups column and is always present. The source for Talkback can be any available mono input.

To assign an input for Talkback:

1 Click to highlight Talkback at the top of the Groups page of the Monitor Profile Configuration window.

2 In the Channel column in the right pane, right-click <add channel> and select the input source for the Talkback mic.

3 If desired, click to edit the Label and Trim for the Talkback input.

To add Thunderbolt inputs (if the Thunderbolt 3 card is installed):

1 Click on Talkback at the top of Settings > Monitor Profile window.

2 Right-click on <add channel> to select one or more (summed) sources for the Talkback input.

Monitor group with assignments: stereo output, stereo source, stereo to mono fold down, and stereo meters

Assigning Talkback input
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Monitor
You must manually add or import monitor groups. Every monitor group includes the following attributes: Sources, Outputs, Fold 
down, and Meters. Each monitor group that you add can be designated as a Cue or Master monitor. Each monitor group can also be 
assigned to EUCON monitor control.

To create a new monitor group:

1 Right-click in the left pane and choose Add monitor.

2 Right-click Monitor and choose Rename (or double-click the name in the Groups column), and type a descriptive name (such as 
“CR” or “Control Room,” or “HP 1” or “Headphone 1”—use shorter names for displays on EUCON-compatible control surfaces).

3 Right-click on Monitor to set the Monitor mode to either Cue or Master.

4 If desired, right click on Monitor again to set the EUCON mode to Control Room, or one of Monitor A–D.

5 Click the reveal triangle to the left of the new Monitor group to show its attributes. 

Now you can proceed to add and assign Outputs and Sources. You can also add Fold downs and outputs for external Meters if desired.

To remove a Monitor group:

 Right-click the monitor group and choose Remove monitor.

Monitor Output Sets

You can add multiple output sets of any format (channel width) to a Monitor group. If there are multiple Outputs, the selected Output 
in the Monitor section of DADman is used for monitoring.

To add output sets to a Monitor group:

1 If necessary, click the reveal button to list the attributes of the Monitor group.

2 Right-click on Outputs under Monitor and choose Add new set. Once you have created a new output set, it can be added to additional 
Monitor groups from Add existing set in the Right-click menu.

Right-click to Add monitor

Monitor group with no assignments
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3 Right-click New output set and choose Rename (or double-click the name in the Groups column), and type a descriptive name.

4 Right-click the output set and select the desired channel width from Set group format. Choose from the available preset formats 
(such as Stereo or 5.1). You can also create custom formats (see Group Formats) to choose from.

5 Select the output set. The right pane lists all channels in the output set.

6 In the right pane, right-click each channel of the selected output and select the desired output assignment from the available outputs 
(such as DA > DA, ch. 1).

Add new output set

Set group format
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7 If desired, click in the Label column of each row and type a descriptive label.

8 To adjust the trim on any channel, click in the Trim column for any channel and type a negative value to attenuate or a positive value 
(in dB) to boost the output signal for that channel.

Once you have made all assignments for the output set, you can repeat these steps to add additional output sets to the monitor group. You 
can select the desired output set for monitoring in the Monitor section of the DADman window. 

To remove an output set:

 Right-click the output set and choose Remove set.

Talkback Mode for Output Sets

If you have assigned an input source for Talkback (see Talkback), you can set the Talkback mode for any Monitor group Output (applies 
to all Outputs sets for the selected Monitor group).

To set the Talkback mode for a Monitor group Output:

 Right-click Outputs and select one of the following from Set Talkback mode:
 

No TB No Talkback for this Monitor group.

No TB, Dim Talkback is not injected, but on Talkback press the program is dimmed.

No TB, Cut Talkback is not injected, but on Talkback press the program is cut.

TB, No att Talkback is injected on Talkback press with no attenuation.

TB, Dim Talkback is injected on press and program is dimmed.

TB, Cut Talkback is injected on press and program is cut.

Setting Talkback mode
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Monitor Sources

You can add multiple Sources of any format (channel width) to a Monitor group. If there are multiple Sources, and the source selec-
tion mode is set to Switched, the selected Source in the Monitor section of DADman is used. In Summed mode, all defined sources (or 
all selected sources) are summed for monitoring.

To add Sources to a Monitor group:

1 If necessary, click the disclosure triangle (Mac) or + button (Windows) to list the attributes of the Monitor group.

2 Right-click on Sources under Monitor and choose Add new set. Once you have created a Sources set, it can be added to additional 
Sources from Add existing set.

3 Right-click the New input set and choose Rename. Type a descriptive name.

4 Right-click the input set and select the desired channel width from Set group format. Select from the available preset formats (such 
as Stereo or 5.1). You can also create custom formats (see Group Formats).

5 Select the input set. The right pane lists all channels in the input set.

6 In the right pane, right-click each channel of the selected input set and select the desired inpuy assignment from the available inputs 
(such as DigiLink 1 > DigiLink 1, ch. 2).

 

7 If desired, click in the Label column of each row and type a descriptive label.

8 To adjust the trim on any channel, click in the Trim column for any channel and type a negative value to attenuate or a positive value 
(in dB) to boost the input signal for that channel.

Once you have made all assignments for the input set, you can repeat these steps to add additional input sets. You can select the desired 
input set for monitoring in the Monitor section of the DADman window. 

To remove an input set:

 Right-click the input set and choose Remove set.

Assigning Right channel for selected source
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Fold Downs

You can add any Fold downs that are defined in the Fold Down page (see Fold Down Page) for use with the monitor group. If you have 
added multiple Fold downs to a Monitor group, you can select (or deselect) any one of them in the Monitor section of the DADman win-
dow. When selected, that Fold down is used for the Monitor group. For example, if you are monitoring a 5.1 source over headphones, 
use a 5.1 to Stereo fold down. If no Fold down is selected, no Fold down is applied.

To add Fold down to a monitor group:

1 Click the Fold down tab and setup any fold down matrices that you want to be available for use (see Fold Down Page).

2 In the Groups page, right-click Fold down under the monitor group select the desired configured fold down from Add fold down.

Repeat these steps to add additional fold downs.

To remove a fold down from a monitor group:

 Right-click the fold down and choose Remove fold down.

External Metering

You can assign one or more output sets for an external metering system (such as one from TC Electronics or DK Technologies). Assign 
any metering output sets to parallel assigned monitoring output sets.

To add a parallel output to an external metering system:

1 Right-click on Meters and choose Add new set or Add existing set.

2 To specify Pre- or Post-Fader operation, right-click on Meters, choose Set meter mode, then select the desired mode. Typically you 
want to use pre-fader for recording workflows and post-fader for mixing workflows.

Adding 5.1 to stereo fold down for monitoring
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3 Right-click New output set and choose Rename (or double-click the name in the Groups column), and type a descriptive name.

4 Right-click the output set and select the desired channel width from Set group format. Choose from the available preset formats 
(such as Stereo or 5.1). You can also create custom formats (see Group Formats) to choose from.

5 Select the output set. The right pane lists all channels in the output set.

6 In the right pane, right-click each channel of the selected output and select the desired output assignment from the available outputs 
(such as DA > DA, ch. 1).

7 If desired, click in the Label column of each row and type a descriptive label.

8 To adjust the trim on any channel, click in the Trim column for any channel and type a negative value to attenuate or a positive value 
(in dB) to boost the output signal for that channel.

Once you have made all assignments for the output set, you can repeat these steps to add additional output sets to the monitor group for 
external metering.

To remove an output set from Metering:

 Right-click the output set under Metering and choose Remove set.

Remove Unused Groups button
Click the Remove Unused Groups button to remove any defined (existing), but unassigned input or output sets in the monitor profile. 
This can be helpful if the Monitor Profile is not functioning as expected.

Fold Down Page
The Fold down page lets you select preset Fold down matrices to add to monitor groups (see Fold Downs). You can also create custom 
fold down matrices. For any selected fold down matrix, you can attenuate or boost inputs to ensure the optimal dynamic balance in the 
fold down output.

To add a preset fold down matrix:

1 In the Monitor Profile Configuration window, click the Fold down tab.

2 In the Fold down column on the left side of the Fold down page, right-click and select the desired fold down matrix from Add preset 
matrix.

Adding 5.1 to stereo fold down
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Repeat this step to add more fold down options for monitoring.

To rename a fold down matrix:

1 In the Fold down column on the left side of the Fold down page, right-click the fold down matrix you want to rename and choose Re-
name, or double-click it.

2 Type a new name and press Return (Mac) or Enter (Windows).

To remove a fold down matrix:

 In the Fold down column on the left side of the Fold down page, right-click the fold down matrix you want to remove and choose 
Remove matrix.

To add a custom fold down:

1 In the Monitor Profile Configuration window, click the Fold down tab.

2 In the Fold down column on the left side of the Fold down page, right-click and choose Add new matrix.

3 Right-click New fold down and choose Rename, or double-click it and type a descriptive name (like St>M for stereo to mono).

4 Click to select the new fold down.

5 Select the input channel format from the Input selector (such as Stereo).

6 Select the output channel format from the Output selector (such as Mono).

7 In the resulting matrix (L/R to C), type any desired gain adjustment for the input channels (such as –3.00 dB for L and R).

Attenuating input gain of L and R source channels
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Fold-down and Speaker Match
DADman lets you define a summing matrix (fold-down), mainly to play back a higher channel count signal as source on a speaker set 
with fewer channels, such as 5.1 to stereo or stereo to mono. You can match between any of the formats. Also, speaker up-match lets 
you play back lower channel immersive formats on more speakers in a higher channel count speaker set-up.

The following figure shows the fold-down and speaker match configuration window. 

Group Formats
The available Custom group formats are referred to by name, such as “51 ch. Immersive.” Formats are available in the Custom format 
list when loaded. There is no allocation of I/O signal or SPQ parameters attached to the group format setting.

Group Type This list has 3 categories: Source set, Output set, and Fold-down.

Source Set This defines a group format related to sources. It includes allocated physical inputs as well as gain adjust settings.

Output Set This defines a group format related to speaker outputs. It includes the allocated physical outputs as well as gain adjust set-
tings and SPQ filter parameters. This provides an easy way to manage different EQ settings for the speaker system.

Fold-down This defines fold-down and speaker match summing matrices. When loaded, the fold-down is available in the fold-down 
list.
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Configuring Custom Speaker and Source Formats
DADman lets you setup the Monitor Profile Configuration with custom speaker and source formats. Group formats are used for defining 
the channel formats for sources and outputs. This lets you connect and match the input sources to the outputs (each of which can be any 
of the defined formats), so left goes to left, right to right, and so on. This has a well-defined coherence in the existing default Preset for-
mats. In the Custom formats editor, group formats using the well-defined role tags can be created, thus making almost any speaker map-
ping possible. A speaker output can also reuse speakers from other speaker outputs with in the control room environment. When select-
ing Preset formats, predefined Group formats can be viewed.

When selecting Custom formats, Custom Group formats can be created and edited, as shown in the picture below. If Create new for-
mat is selected, an editor window will open (not shown) for fast configuration of larger immersive speaker formats (such as for Dolby 
Atmos mixing stages).
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The Custom Group formats can also be created or edited by selecting parameters directly in the column view as shown in the following 
picture.

Formats with cross-over filters for active speakers, such as left and right in an immersive set-up, can also be created when working 
creatively with the group configurations. Note that the system does not provide protection if incompatible speaker configuration pro-
files are loaded sourcing (such as tweeter speakers), which can be easily destroyed if correct filtering is not applied to the signals.
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Mom Page
The Mom page lets you assign a MOM unit (monitor operating module) for controlling monitoring, if you have one on the network, and 
make control assignments for the selected MOM.

Mom page, MOM unassigned, Layer 1 default assignments 
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Chapter 8: SPQ Processing

MTRX II provides 1,024 filters for up to 128 channels of SPQ processing to tune your speakers for monitoring.

EQ
The EQ for all speaker channels in the control room speaker set can be edited and viewed by activating the EQ>> button. Note that 
the button does not enable or disable the filters, it just changes the view.

EQ Filter Resources
SPQ processing resources required by the EQ vary depending on configuration and sample rate. As with the summing engine 
viewer, the SPQ viewer shows the available and used resources for the filters (out of 1,024 filters and 128 channels).

DADman EQ Management Window
EQ view shows the assigned EQ for the selected speaker channel of the selected output speaker set. The channel delay knob con-
trols the delay of the selected channel. This delay can be set between 0–600 ms in resolution of samples down to 10 milliseconds, 
equivalent to the resolution of the general delay setting.

The figure below shows the left channel with four EQs configured. They are shown in the graph with matching colors. The resulting 
EQ response for all the enabled filters is shown as a white line. In the example below, the EQ is not enabled for the channel so the 
response is flat.

Monitor section with expanded EQ view
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When activating the EQ>> button the filters are activated as shown in the figure below—the white curve shows the resulting frequency 
response for the EQs on the selected channel.

Configuring the EQ Channel
Following are descriptions of the various EQ controls used for configuring and editing an EQ channel.

Add Eq/Remove Eq Adds (or removes) an EQ to the view, both as a selection knob (named Eq 1 to 16), and as a flat curve. A total of 
16 EQs can be added. In the same way a selected EQ can be deleted by activating Remove Eq. When an EQ is added the EQ type can 
be selected by the Eq Type drop down menu. Frequency, Gain, and Q can be set for the selected EQ filter, and the curve in the view 
will reflect the setting.

Frequency, Gain, and Q Values can be set with the mouse or by clicking the value field and using numerical entry with the keyboard.

Act Activates (or deactivates) the EQ filter of one particular selected EQ filter to another channel, whereas the EQ>> button referred 
to above enables (or disables) a whole set of filters for the particular channel.

Copy All The total combination of the EQ filters for a channel can be copied and pasted on at other channel. Click Copy All on the chan-
nel you want to copy. Select another channel in the speaker set and click Paste All to paste the filter configuration. The Paste All button 
is only visible when a curve has been copied.

Eq Types The following EQ types are available:

• Parametric EQ filter

• Shelving filter: High Pass or Low Pass

• Butterworth filter: High Pass or Low Pass

• Linkwitch Riley: High Pass or Low Pass
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The preceding figures show configurations for a stereo speaker set. When configuring the speaker set, select the speaker format from 
the preset or custom format list. The 5.1 speaker set is the selected output speaker set in the following figure. The speaker output sets 
can be configured freely in the monitor profile editor. An additional curve is shown in the graph reflecting the presence of the LFE chan-
nel.

When a speaker set format with one or more speaker SUB channels is selected like 5.1 with one LFE channel, it is also possible to apply 
bass management functionality to the speaker set.

Bass Management for a speaker set is enabled by activating the BMngt button as shown in the figure above. Once this is enabled the 
curve for the selected speaker will reflect the high pass filter applied in the white resulting curve. When selecting the LFE/SUB channel 
the response for the low pass filtered curve is shown. The low pass filter curve is also shown the in the non-SUB channels as an addi-
tional information. 

Configuring Bass Management
The configuration of the Bass Management system is done in the Monitor Profile Configuration window. A Bass Management config-
uration can be made for all speaker output sets, where the speaker format comprises one or more LFE/SUB channels. In relation to the 
format conventions a translation is made between what is the LFE channel in the signal source, and what are the subwoofer speakers in 
the speaker setup, and in that relation the mapping between LFE, Bass managed speaker channels and subwoofer speakers is also made. 
For example, the traditional subwoofer setup for a 5.1 speaker system has the subwoofer connected to the LFE source channel, but Bass 
Management can be applied as well filtering the low frequency from the surround speakers to the subwoofer speaker. This is the Basic 
Bass Management configuration also applied in Pro Mon.

For information on configuring bass management, see Configuring Bass Management.
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In order to configure the Bass Management setup in general or to make a starting point for a more complex Bass Management system, 
such as with multiple subwoofer speakers, configuration is done in the Bass Management configuration window selected for the relevant 
speaker set, as shown in the following picture.

When selecting Bass Management preset an editing window appears as shown in the following picture.

All speakers in the profile will have applied a high pass filter, and the summing for the SUB woofer will have the applied the low pass 
filter with the entered parameters. The Summing of the LFE source will have applied the selected low pass filter as well. A 10 dB gain 
on the LFE channel can be applied as well.

Note if 10 dB is applied to the LFE channel it will be active on the output speaker setting, and all sources selected to the speaker set 
will get the additional gain on the LFE channel. Alternatively the raise in LFE gain can also be set in the input configuration for the 
sources where this is needed.
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When the Bass Management preset have been applied to the output set it can be viewed and further edited in the monitor profile window 
for the actual speaker set. As shown in the following pictures, the Bass Management filter configuration for each speaker channels is vis-
ible when scrolling the window horizontally.

The settings shown in the right-hand columns reflect the selections made in the configuration window described above with the param-
eters listed out for each speaker channel. Each filter parameter can be edited individually for each channel. Note the column Level sub. 
0 dB indicates that the surround channel is summed with unity gain to the SUB. Also, the 10 dB gain for the LFE can be seen. If a dif-
ferent gain structure for the sub signals is needed, this can be edited here. If a speaker format has been selected with more than one SUB, 
a summing matrix can be established by editing the levels in the SUB columns to allocate SUB woofers to selected surround speakers.
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Chapter 9: Controlling MTRX II Preamps from Pro Tools
(Mac Only)

On Mac, you can control the microphone preamps for installed Pro Tools | MTRX 8-channel Mic/Line AD cards and using the PRE 
controls in Pro Tools (as well as from Pro Tools–compatible MIDI and EUCON control surfaces).

Configuring Audio MIDI Setup
Use the IAC Driver in the macOS Audio MIDI Setup utility to route MIDI between Pro Tools and MTRX II.

To configure Audio MIDI Setup (AMS) for Pro Tools PRE control of MTRX II:

1 Do one of the following:

• In Pro Tools, choose Setup > MIDI > MIDI Setup.

• Launch Audio MIDI Setup (AMS) from the Finder (/Applications/Utilities/Audio Midi Setup).

2 In AMS, choose Window > Show MIDI Studio.

3 Ensure that two virtual MIDI busses are available in the Audio MIDI Setup IAC Driver and that Device is online is enabled.

4 Quit Audio MIDI Setup.

Audio MIDI Setup with two IAC busses
Chapter 9: Controlling MTRX II Preamps from Pro Tools (Mac Only) 58



Configure DADman
Once Audio MIDI Setup is configured, setup DADman for MIDI.

To configure DADman for Pro Tools PRE control of MTRX II units:

1 Launch DADman software.

2 Choose Settings > MIDI Settings.

3 Select Bus 1 for MIDI Input and Bus 2 for MIDI Output.

4 Select Pro Tools PRE for MIDI Mode.

5 Click the red button in the upper-left corner of the window to close it.

6 Leave DADman running in the background while running Pro Tools.

Configure Pro Tools Software
To configure Pro Tools for PRE control of MTRX II units:

1 In Pro Tools, choose Setup > Peripherals. 

2 Click the Mic Preamps tab.

3 Select Type > PRE.

4 Select Receive From > Predefined IAC Driver Bus 2 > Channel 1 in the pop-up menu.

5 Select Send To > Predefined IAC Driver Bus 1 > Channel 1 in the pop-up menu.

6 Click OK.

7 Choose Setup > I/O Setup.

8 Click the Mic Preamps tab.

9 Click on the first channel where the MTRX II is physically connected.

DADman MIDI Settings window

Pro Tools Peripherals, Mic Preamps page

Pro Tools I/O Setup, Mic Preamps assigned to eight channels 
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10 Double click the Name PRE #1 and type MTRX II (or similar) to clearly identify MTRX II mic pres.

11 Click OK.

Assign discreet MIDI inputs to MIDI and Instrument tracks that are assigned to Virtual Instrument plug-ins to avoid any 
possible conflicts with MIDI messages used for controlling Mic Pres.

in case you don’t want to block certain CC messages globally (bear in mind that the PRE protocol itself uses >70 MIDI CC 
messages so filtering them all would be pretty painful and possibly debilitating!). The most troublesome is MIDI CC 10 (which 
PRE uses for periodic handshaking, but directly conflicts with MIDI pan) so filtering that one out should help most folks who run 
into this - unless of course they want to control pan from a hardware MIDI controller…

Maybe I should author a KB article that goes into the nitty gritty of all this (unless it makes sense to go into detail in the PDF 
guides instead, or both - thoughts?). All the CC messages that the PRE protocol uses are actually documented in the old PRE 
guide (page 41 of http://akmedia.digidesign.com/support/docs/PRE_Guide_v80_56123.pdf) so might be good to present that 
somewhere more recent too.

see https://avid-ondemand.atlassian.net/browse/PT-310984

Controlling MTRX II from Pro Tools
(or from a Control Surface)

Once configured, Pro Tools can control MTRX II Mic Preamp settings on a channel-by-channel basis. Enable Mic Preamps view in ei-
ther the Edit or Mix window to access these controls (View > Mix Window Views > Mic Preamps or View > Edit Window Views > Mic 
Preamps). All adjustments made in Mic Preamps view in Pro Tools are mirrored in DADman.

From Pro Tools Mic Preamps view you can control the following MTRX II Mic Pre parameters:

Mic/DI Select the microphone input setting for the corresponding input channel in MTRX II (Mic or DI only, Line does nothing) .

ø Inverts the polarity of the mic input.

Filter No effect.

Pad Moves the fader 18 dB down (reflected in DADman). In pad mode the level of the mic pre can be adjusted in a range from –18 dB 
to +51 dB.

Insert No effect.

Be sure to filter out Mic Pre MIDI messages so that they do not interfere with Virtual Instruments (see Pro Tools Reference Guide).

Pro Tools Mic Pre window (left), Pro Tools Mic Pre view (middle), and DADman Channel strip (right)
Chapter 9: Controlling MTRX II Preamps from Pro Tools (Mac Only)
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48v Enables phantom power for the mic input.

Fader 0–69 dB range.
Chapter 9: Controlling MTRX II Preamps from Pro Tools (Mac Only)

61



Appendix A: Specifications

Audio Specifications

Analog Input

Analog Output

Sampling, resolution 5-bit sigma/delta @ 5.645 or 6.144 MHz, 24-bit PCM

PCM (DXD) sample rates 44.1, 48, 88.2, 96, 174.4, 192, 352.8, 384 kHz

DSD sample rates 8224 & 5.6448 Mhz (64 & 128 fs)

Dynamic range (A) > 123 dB

THD+N(A) < –117 dB @ –3dB FS / 0.00014%

Cross talk < –120 dB

Input Impedance (differential) > 10 k Ohm

Max input level Adjustable from 9 dBu to 30 dBu in steps of 0.1 dB

Microphone input gain range/accuracy Adjustable from –18 to +70 dB, in steps of 0.1 dB
± 0.25 dB accuracy

Microphone equivalent input noise (A) 133 dB

Modulator resolution, format 32 x oversampling, 1 bit DSD, 24 bit PCM 

PCM (DXD) sample rates 44.1, 48, 88.2, 96, 174.4, 192, 352.8, 384 kHz

DSD sample rates 8224 & 5.6448 Mhz (64 & 128 fs)

Dynamic range (A) > 128 dB

THD+N(A) < –110 dB @ –3dB FS / 0.00031%

Cross talk < 120 dB

Max output level Adjustable from –60 dBu to 24 dBu in steps of 0.1 dB
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Digital I/O and Synchronization

Network Interface

Electrical Specifications

Power supply cord must be min. light sheathed flexible cord according to IEC60227 (designation 60227 IEC 52) and include a protec-
tive earth conductor having a green-and-yellow insulation. Cross-sectional 
areas min. 3 x 0.75mm.

Digital I/O formats
Supported sample rate

AES/EBU, Pro Tools DigiLink Mini, Dante IP Audio/up to 
192 kHz, MADI/up to 384 kHz and DSD, Thunderbolt up 
to 384 kHz

Synchronization/sample rate AES11, Word Clock, All digital inputs, Video Sync (word 
clock connector) / PAL, NTSC, SECAM

DSD sample rates 8224 & 5.6448 Mhz (64 & 128 fs)

Interface 1000BASE-T, RJ45 connector, 4-pair connection

Power consumption 120 VA maximum

Input voltage 90–260 VAC
100–240 VAC Nominal, 47–63 Hz

Mains fuse, mounted in IEC connector 1.5A, T1AH/250V

Mains line plug type Correct type acc. to standard

110–125V UL817 and CSA C22.2 no 42

220–230V CEE 7 page VII, SR section 107-2-D1/IEC 83 page C4

240V BS 1363 of 1984.Specification for 13A fused plugs and 
switched and un-switched socket outlets
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Mechanical Specifications

Chassis air flow from front to rear:

Environmental Specifications

ThunderBolt 3 Option Card Specifications

Chassis standard 19”, 2 RU

Chassis depth, without connectors mounted 35.0 cm / 13.8”

Chassis body width 43.5 cm / 17.2”

Weight, not including I/O cards 5 kg / 11 lbs.

Operating Temperature 0–40º C / 32–104º F

Interface Thunderbolt 3 Interface with USB-C connectors

Sample rates 44.1, 48, 88.2, 96, 174.4, 192, 352.8, 384 kHz

Channels When installed in MTRX II: 256 channels at 96 kHz and below, 
128 channels at 176.4/192 kHz, and 64 channels at 384 kHz

Resolution 32 bit floating point audio data

Control Control channel for DADman for control of the audio interface

Daisy Chain up to 6 devices can be daisy chained. Each device appears sep-
arately in the driver / CoreAudio. 
Note that for ASIO windows only one interface is possible
Appendix A: Specifications 64



Appendix B: Installing MTRX Option Cards
The analog and digital I/O capacity, and processing of Pro Tools | MTRX II can be expanded with any combination of option cards, 
ranging from none to all eight of any variety: 

Analog I/O You can install up to eight A/D or D/A cards in any combination, for up to 64 analog audio channels. 

Digital I/O You can install up to eight digital I/O expansion cards for additional AES3, 128-channel IP Audio Dante, MADI, and SDI 
input and output. You can also install an optional Dual MADI mini-module.

DigiLink You can install up to eight DigiLink expansion cards for up to 576 channels of I/O between Pro Tools and MTRX II (including 
the built-in DigiLink ports). Each DigiLink card provides up to an additional 64 channels of DigiLink I/O.

Overview of Installation
Installing expansion cards involves the following steps:

1 Preparing for the installation

2 Removing the top panel

3 Installing and connecting the expansion card

4 Completing the installation

Preparing for the Installation
Before installing expansion cards, collect the required materials and prepare your work area. 

To prepare for the installation: 

1 Make sure you have collected the required materials: 

• One or more MTRX II Expansion Card packages. 

• Anti-Static wrist strap (not included).

• Foam or other padded surface to place the card on (not included).

• The following tools: 

• #1 Phillips screwdriver (not included).

• If installing a MTRX II MADI module, you will also need a small flathead screwdriver and a 3/16-inch socket or similar sized open 
end wrench. 

2 Put on your anti-static wrist strap and configure according to its instructions.

3 Make sure the MTRX II is powered off and disconnect any cables connected to it. 

4 Place the MTRX II on a table or other flat surface. 

5 Make sure your surface is clear of any debris and that you have a padded surface nearby to place the expansion card if you need to 
set it down during installation.
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Opening the MTRX II Chassis
To open the MTRX II Chassis: 

1 Use a #1 Phillips screwdriver to remove the screws on the top and sides of the unit that secure chassis cover. Carefully set each screw 
aside as you remove them and keep them nearby to reattach the chassis cover after cards are installed. 

2 Set the chassis cover aside. 

Installing an Expansion Card
Installation steps differ slightly depending on the type of expansion card you are installing. If you are installing any of the following an-
alog or digital I/O cards, or a processor card, see Installing Expansion Cards:

• MTRX 8 Line Pristine AD card

• MTRX 2 Mic/Line Pristine AD card

• MTRX 8 Mic/Line Pristine AD card

• MTRX Pristine 8 DA card

• MTRX 8 AES3 I/O card

• MTRX Dante 128 card

• MTRX Dual SDI/HD/3G card

• MTRX Dual MADI I/O card

• MTRX DigiLink card

Installing Expansion Cards
Expansion cards are installed into slots along the back of the unit. All eight slots can be used. Up to eight analog cards can be installed.
Orientation, connector and ports of an example Expansion Card (MTRX 8 Pristine DA card shown)
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To install an expansion card:

1 Standing at the back of the unit, use a #1 Phillips screwdriver to remove the faceplate covering the slot where you want to install the 
card. For example, to install a card into slot 1 remove the two fasteners securing the faceplate on slot 1 shown below. 

Set the fasteners aside (you will use them to secure the new card to the unit after the card is installed).
2 Remove the expansion card from its packaging, being careful to handle it by its edges only. 

3 Orient the card with its external connectors facing you (towards the back of the unit) and its PCIe 
connector also facing the back of the unit.

4 Align the card in the corresponding guide rails on the bottom of the unit. Ensure any internal cables (such as the ribbon cable near 
slot 8) are laid under the card.

Faceplate removed from slot 1
5 Align the PCIe connector on the card with the PCIe port mounted in the unit. 

Guide rails for slot 1 
Side view showing card PCIe connector aligned with unit PCIe port
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6 Making sure to guide the audio connectors through the open slot on the back of the unit, carefully push the card towards the back of 
the unit until it seats fully into its PCIe connector. 
7 Once the card is seated completely in its slot, secure it to the unit using a #1 Phillips screwdriver and the fasteners you removed from 
the faceplate in step 1. Note that the fasteners are threaded into different threaded holes than when they were securing the faceplate. 

Pushing the card into its PCIe connector
8 Proceed to Completing the Installation.

Installing a MTRX MADI Module
The MTRX MADI module is a daughter card that is mounted to the motherboard. Installing a MADI module involves freeing the moth-
erboard from the chassis, installing the MADI module onto its connector pins, then reattaching the motherboard assembly to the chassis. 
In addition to a #1 Phillips screwdriver, you will also need a small flathead screwdriver and a 3/16-inch socket or similar sized open end 
wrench. 

Fasteners re-installed to secure the card into slot 1
MTRX MADI module, top (shown at left) and underside showing connector (at right)
 68



To install a MTRX MADI module:

1 Remove the two fasteners that secure the faceplate over the Optical I/O slot and remove the faceplate. 

Set the screws aside (you will use them later to secure the card to the unit). 
Fasteners securing the Optical I/O faceplate
2 Carefully position the MADI module in the unit so that the receiving holes on the underside of the MADI module align with the 
MADI connector pins on the motherboard. 

The MTRX MADI module has been modified since its original production to make it easier to install. If you have a newer module, you 
do not need to remove the motherboard and you can skip steps 2 through 4, and steps 7 and 8. For more information, refer to this 
online video at: https://www.digitalaudiosupport.com/madi-module-installation/
3 With the card aligned, gently push the MADI module down so that it is fully seated on its connector. 

Side view of MADI module aligned with the connector on the motherboard 
Side view of MADI module fully seated on its connector
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4 From the back of the unit, secure the MADI module to the back panel using the two faceplate screws you removed earlier (two extras 
are included with the MADI module). 
5 Proceed to Completing the Installation.

Completing the Installation
After installing cards, reassemble the unit by replacing its top panel and then power on your system to confirm the installation.

To replace the top panel: 

1 Replace the top panel, making sure to orient it correctly so that the tabs on its front edge fit under the unit faceplate. 

2 Using a #1 Phillips screwdriver, replace the 11 fasteners you removed earlier and secure the top panel to the unit. 

To confirm installation: 

1 Make sure your switchable power source (power strip or other) is off. 

2 Connect power to the MTRX II using the included IEC power cable. 

3 Switch on your power source. 

4 Wait for the unit to initialize. Check the front panel display for status. 

5 Power off the unit. 

Location of fasteners to secure MADI module to the back panel
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Appendix C: Installing Thunderbolt 3 Option Module
The optional Avid Thunderbolt 3 module with two Thunderbolt 3 ports can be installed in Pro Tools | MTRX II for up to 256 channels 
of I/O (256 channels with either port) between your computer and MTRX II. The Thunderbolt 3 module is designed to work with 
MTRX II and MTRX Studio. The module has two Thunderbolt 3 ports and a PCIe connector for the audio interface hardware.

The bus format of the PCIe interface works only with MTRX II and MTRX Studio chassis, and not as a module in a computer. The Thun-
derbolt 3 module however enables PCIe extension to a computer providing fast transfer (DMA) of digital audio data over Thunderbolt 
from the computer audio application to the audio interface.
Overview of Installation
Installing expansion cards involves the following steps:

1 Preparing for the installation

2 Installing the Thunderbolt 3 module

3 Installing and configuring the Thunderbolt 3 driver

4 Installing and configuring DADman software.

Example music studio configuration

Computer

Docking/
Expansion

Thunderbolt 3
card

MTRX II

AUDIO I/O

PCIe

DAD COREAUDIO
DRIVER SOFTWARE

USB-C THUNDERBOLT 3 
DAISY CHAINCONNECTION

MTRX II
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Preparing for the Installation
Before installing expansion cards, collect the required materials and prepare your work area. 
To prepare for the installation: 
1 Make sure you have collected the required materials: 

• Thunderbolt 3 option module.

• Thunderbolt 3 cable (not included).

• Anti-Static wrist strap (not included).

• Foam or other padded surface to place the card on (not included).

• #1 Phillips screwdriver (not included).

2 Put on your anti-static wrist strap and configure according to its instructions.

3 Make sure the MTRX II is powered off and disconnect any cables connected to it.

4 Place the MTRX II on a table or other flat surface. 

5 Make sure your surface is clear of any debris and that you have a padded surface nearby to place the option card if you need to set it 
down during installation.

Hardware Installation
When the MTRX II is connected using Thunderbolt 3—and for macOS, the DAD CoreAudio driver is installed—the unit is recognized 
as a sound device in CoreAudio and audio applications on the computer can use this interface. When installing DADman control soft-
ware on the computer the MTRX II unit can be controlled and managed over the Thunderbolt 3. This is automatically detected in DAD-
man.

To install the Thunderbolt 3 option module: 

1 Use a #1 Phillips screwdriver to remove the screws on the top (10 screws) and sides (8 screws, 4 on each side) of the unit that secure 
chassis cover. Carefully set each screw aside as you remove them and keep them nearby to reattach the chassis cover after cards are 
installed. 

2 Set the chassis cover aside.

3 Standing at the back of the unit, use a #1 Phillips screwdriver to remove the 2 screws securing the faceplate covering the 
Thunderbolt 3 slot on the back of MTRX II.

4 Remove the Thunderbolt 3 option module from its packaging, being careful to handle it by its edges only. 

5 Orient the card with its external connectors facing you (towards the back of the unit) and its PCIe connector also facing the back of 
the unit.

6 Align the PCIe connector on the card with the PCIe port mounted in the unit.
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7 Making sure to guide the audio connectors through the open slot on the back of the unit, carefully push the card towards the back of 
the unit until it seats fully into its PCIe connector.
8 Once the card is seated completely in its slot, secure it to the unit using a #1 Phillips screwdriver and the screw included with the 
Thunderbolt 3 Option module.

Thunderbolt 3 Option module installed in MTRX II
9 Replace the top panel, making sure to orient it correctly so that the tabs on its front edge fit under the unit faceplate. 

10 Using a #1 Phillips screwdriver, replace the screws you removed earlier and secure the top panel to the unit.

Thunderbolt 3 option module installed in MTRX II
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11 Using a Thunderbolt 3 cable, connect an available port on the Thunderbolt 3 module to your computer.
Driver and DADman Installation
On macOS, the driver interacts with CoreAudio and there is an ASIO driver for Windows. The capacity of the design provides bi-di-
rectional transfer of up to 256 32-bit floating point audio channels with a sample rate of 96 kHz. This gives a maximum data rate of ap-
proximately 1 Bbps. The macOS driver supports OS11 and 12 and Apple Silicon without Rosetta, and the ASIO driver supports Win-
dows 10.

In order to install and work with the system the following is required:

1 Thunderbolt 3 module installed in MTRX Studio hardware audio interface

2 High Speed Thunderbolt 3 20 Gbps or 40 Gbps USB-C cable, preferably Intel Certified (not included)

3 On macOS

• DAD Thunderbolt 3 Core Audio Driver, v.1.1.22 or later

• DADman for Mac, v.5.6.7.1 or later 

On Windows

• DAD Thunderbolt 3 ASIO Driver, v.1.0.8 or later

• DADman for Windows, v.5.6.7.1 or later

Install and Configure Drivers
On macOS, the driver interacts with CoreAudio and there is an ASIO driver for Windows. The capacity of the design provides bi-di-
rectional transfer of up-to 256 32-bit floating point audio channels with a sample rate of 96 kHz. This gives a maximum data rate of ap-
proximately 1 Bbps. The macOS driver supports OS11 and 12 and Apple Silicon without Rosetta, and the ASIO driver supports Win-
dows 10.

In order to install and work with the system the following is required:

1 Thunderbolt 3 module installed in MTRX II hardware audio interface

2 High Speed Thunderbolt 3 20 Gbps or 40 Gbps USB-C cable, preferably Intel Certified

3 On macOS

• DAD Thunderbolt 3 Core Audio Driver, v.1.1.22 or later

• DADman for Mac, v.5.6.7.1 or later 

Thunderbolt 3 option module installed in MTRX II, Thunderbolt 3 cable connected
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On Windows

• DAD Thunderbolt 3 ASIO Driver, v.1.0.8 or later

• DADman for Windows, v.5.6.7.1 or later

Install the Thunderbolt 3 Core Audio Driver on macOS
The Thunderbolt 3 module Core Audio driver is required to use MTRX II over Thunderbolt 3 with your Apple computer.

To install the Thunderbolt 3 module Core Audio driver on macOS:

1 Download the Thunderbolt 3 module driver.pkg file to your computer from your Avid Master account.

2 Double-click the driver installer package.

3 Follow the on-screen instructions.

4 When prompted, enter your Administrator password and click Install.

5 When prompted, click Open Security Preferences.

6 In the Security and Privacy System Preferences, click Allow.

7 When prompted, restart your computer.

8 After restart, open the Thunderbolt 3 driver application and connect the DAD Thunder|Core interface to the Thunderbolt 3 port on 
the Computer. Make sure that you are using a high-speed (20Gbps) Thunderbolt 3 cable.

Core Audio Driver Configuration
Once the driver is installed and a DAD Thunder|Core interface is connected to the Thunderbolt 3 port on the computer, the driver can 
be set-up with the relevant configuration by opening up the DADDriverSetup application.
Device Selection Lets you select any of the interfaces connected by Thunderbolt.

Sample Rate Select the desired sample rate for the connected audio interface: 44.1, 48, 88.2, 96, 176.4, 196, 352.8 or 384 kHz

Channels Select the desired number of channels you want to make available for Core Audio applications on your computer: 64, 128, 
or 256 channels. 

All connected and configured interfaces support up to 256 bi-directional channels in the audio hardware.

Core Audio Driver Control Panel
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Install the Thunderbolt 3 ASIO Driver on Windows
To install the Thunderbolt 3 module ASIO driver on Windows:

1 Download the Thunderbolt 3 module driver.exe file to your computer from your Avid Master account.

2 Double-click the downloaded installer file.

3 Follow the on-screen instructions.

4 When prompted, click Next and then Install.

5 Once the driver is installed, open your audio application and select the Digital Audio Denmark ASIO driver.

To configure the ASIO driver:

1 Open the ASIO Driver Setup control panel from the audio configuration section of your audio application.

2 Configure the control panel as desired.

ASIO Driver Configuration
Device Selection Lets you select any of the interfaces connected by Thunderbolt.

Buffer Size Select the desired Buffer Size (in samples): 16, 32, 64, 256, 512, or 1,024.

It is recommended that you start with a large buffer size to ensure you have stable audio.

Sample Rate Select the desired sample rate for the connected audio interface: 44.1, 48, 88.2, 96, 176.4, 196, 352.8 or 384 kHz

Channels Select the desired number of channels you want to make available for Core Audio applications on your computer: 64, 128, 
or 256 channels. 

The driver window provides various status information for monitoring the PC and audio transfer performance.

ASIO Driver Setup dialog
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Driver Statistics

Missed IRs This number should be 0. The readout shows missed audio interrupts due to other Windows system interrupt priorities.

PCIe load This number is the PCIe bus load and should be low in percentage buts scales with the number of audio channels. The number 
in brackets is the max/peak value.

System Statistics

DPC Latency Deferred Procedure Call (DPC) Latency, This number tells how fast the ASIO driver gets access in the Windows oper-
ating system. This value should be low.
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Appendix D: Network Fundamentals
The following is a basic introduction to networks and how to set them up in relation to Pro Tools | MTRX II or MTRX Studio. Covering 
the entire subject of “network” would require several hundred pages so we will focus on the “need-to-know” parts of it.

What is a Network?
A network allows multiple devices, such as PCs, printers, and many others devices to communicate with each other. As opposed to tra-
ditional audio signals such as AES and MADI, which are point-to-point connections, a network allows any device on the network to 
communicate with any other device on the network.

A network consists of one or more subnets. A subnet is typically a local network in building. A subnet can operate as a closed network 
with no external connections or it can be connected to the Internet.

There are different types of devices in a network, such as PCs, printers, multiple MTRX IIs and or a MTRX Studio, switches, and rout-
ers.

Physical Connections
Devices in a network can be connected through a wide range of media. The most common for local connections is the UTP (Unshielded 
Twisted Pair) cable. This is also referred to as CAT5, CAT5e, or CAT6. There are also other “CAT”-types, but the three mentioned here 
are the most common. UTP cables are normally terminated in an RJ45 connector.

Other types of media can be fiber cables, wireless (WiFi), coaxial cables, and even power cables.

As the MTRX II or MTRX Studio and most computers have an RJ45 connector for use with UTP cables, we will focus on this type of 
interface.

When using UTP cables, it is possible to use different bit rates, typically 10 Mbit/s, 100 Mbit/s, or 1000 Mbit/s (1 Gb/s). The network 
interface on Pro Tools | MTRX II or MTRX Studio and on most computers today support 1 Gb/s. It is therefore important that the ca-
bling supports this bit rate to ensure a stable connection. Cat5 cables do not support gigabit transmission, so never use this type of cable. 
CAT5e and CAT6 cables both support 1 Gb/s, so be sure to use either of these two types. The CAT-type is usually printed on the cable, 
so it is easy to identify.

CAT5e and CAT6 cables contain four twisted pairs (a total of eight wires). In order to achieve gigabit transmission, all four pairs must 
be used. If only two pairs are used, the cable can only support 100 Mbit/s transmission. If you look closely at the RJ45 connector on a 
network cable, you can easily see whether two or four pairs are used.

Example network configuration (MTRX shown)
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Twisted pair cabling like CAT5e and CAT6 comes in two main varieties, solid and stranded. Solid CAT5 cable supports longer length 
runs and works best in fixed wiring configurations like office buildings. Stranded CAT5 and CAT6 cable, on the other hand, is more pli-
able and better suited for shorter-distance, movable cabling such as on-the-fly patch cabling. The maximum cable length for 1 Gb/s 
Ethernet is 100m when using solid cables, for both CAT5e and CAT6. Never assume that you can go any further than that!

Finally, network cables are available as either “straight” or “crossed” cables. This nomenclature is from the “old days” when connecting 
two computers directly to each other. Nowadays most network devices automatically determine whether they should operate with 
straight or crossed connections and will adapt as necessary.

Summary
 Only use CAT5e or CAT6 cables.

 Make sure all four pairs in the cable are used.

 Make sure to use solid cables, and not stranded cables, for long cable runs.

 Never exceed 100 meters distance.

Infrastructure
There are different types of network devices which perform different functions. The main ones are a switch and a router.

Switches are used for connecting local devices together. Switches have a number of ports: typically 5, 8, 16, 24, 32, and upwards. Each 
port can connect to one device. For example, an 8-port switch lets you connect up to eight PCs. Switches are generally non-intelligent 
so they simply provide a connection between the devices.

Routers are used when a subnet needs to connect to another subnet or to the Internet. Routers are intelligent and act as a “gateway” to 
other networks. They handle all traffic that is destined for the “outside world” as well as taking care of any traffic coming from the out-
side. Only one router is allowed in a network.

Most modern routers also perform other functions as well, such as firewall and DHCP-server (see later for more on DHCP). Most routers 
also have a built-in switch to make installation easier.

Summary
 Switches are used for local connections between devices.

 Routers are used for connections to other networks. Routers are only required if the network has to connect to other networks or the 
Internet.

Addressing
Since there can be many devices on a network, it is necessary that each of them has a unique address. This is called an IP (Internet Pro-
tocol) address and each device in a network must be assigned one. The IP address can either be provided automatically by a 
DHCP-server or configured manually in the device as a fixed IP address.

As mentioned previously, most Internet routers have a built-in DHCP-server. When using a DHCP-server, a device is automatically as-
signed an IP address every time it is powered up or restarted. The DHCP-server ensures that no two devices get the same IP address.

The IP address is assigned to a device on power-up, which means that the address can be different after a restart, as the DHCP-server 
simply assigns the device the first available IP-address.

If the device on the other hand is configured with a fixed IP address, the IP address remains the same after a restart. It is perfectly le-
gitimate to build a network where some devices have fixed IP addresses and other devices have DHCP-assigned IP addresses. However, 
it is important to ensure that no devices get the same IP address. If you have a device with a fixed IP-address, it is important that you 
ensure this IP-address does not interfere with other devices on the network.
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In addition to the IP address, the device must also have a subnet mask. The subnet mask helps the device identify which other devices 
are on the same subnet and which are on a different subnet.

On the left-hand side you will find the network settings of the MTRX Studio itself. On the right-hand side you will find the network set-
tings for the Dante Audio over IP module or Dante Expansion card (if either is installed in the MTRX Studio).

If you look at the MTRX Studio settings, the first choice is between Obtain an IP address automatically or Use the following IP ad-
dress. If you select Obtain an IP address automatically, the MTRX Studio is assigned an IP address, Subnet mask, and Default gate-
way automatically by a DHCP-server (if a DHCP-server is present on the network).

If you instead select Use the following IP address you must enter the IP address, Subnet mask, and optionally Default gateway man-
ually.

IP address

The IP address of the unit.

Subnet mask

Determines which devices are on the same subnet. Devices on the same subnet can communicate directly with each other whereas de-
vices on different subnets can only communicate through a router.

Default gateway

An optional parameter. Default gateway is the IP address of the router which would allow the MTRX Studio to communicate with a de-
vice on another subnet. There is no need to provide a Default gateway if the MTRX Studio does not need to communicate with devices 
on other subnets.

So which IP address should you choose? If you use a DHCP-server, then it’s most likely already configured and you don’t need to worry 
about it. If you don’t have DHCP-server, you need to enter IP addresses manually.

IP addresses consist of 4 bytes (numbers), usually written with a decimal pint between them, for example 192.168.0.1. This means IP 
addresses can range from 0.0.0.0 to 255.255.255.255, giving a total of approximately 4.3 billion addresses. The IP addresses are how-
ever reserved for different purposes, so for example some are public (when used on the Internet) and others are private (only used on 
local networks). In order to avoid any problems, it is best to use the addresses reserved for private use, which are:

10.0.0.0 to 10.255.255.255

172.16.0.0 to 172.31.255.255

192.168.0.0 to 192.168.255.255

The subnet mask is necessary to identify which addresses are on the same subnet, and which are outside the subnet. For example, a sub-
net mask of 255.255.255.0 means that all IP addresses where the first three numbers are the same, and are on the same subnet. For an-
other example, 192.168.0.5 is on the same subnet as 192.168.0.21 because the first three numbers (192.168.0) are the same, but 
192.168.1.10 is not on the same subnet because the third number is different.

With a subnet mask of 255.255.255.0, there can be up to 256 devices on the same subnet, as the last number in the IP address goes from 
0 to 255. For example, if you need more than 256 devices on the same subnet, you can change the subnet mask to 255.255.254.0 which 
will give you an additional 256 devices, for a total of 512.

Explaining how the subnet mask is used is rather complicated, so we recommend that you just use 255.255.255.0.

Example network configuration
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Summary
 IP address is the address of a device in a network.

 Subnet mask is used to identify which devices are on the same network and which are outside the network.

 Default gateway is the IP address of the router, in case a connection is required outside the local network.
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Appendix E: Monitoring with MTRX II and S6

Assigning Monitor Sources on S6, S4, or Avid Control 
S6, S4, or Avid Control lets you assign up to 16 sources in the Monitoring screen. 

To access additional sources: 

1 Navigate to the Monitoring screen. 

2 At the top of the screen, swipe the row of Sources to the left to display sources 9–16 (as available). 

Configuring Sources for Pro Tools | MTRX II in DADman
If you are using a Pro Tools | MTRX II with S6, S4, or Avid Control, you need to first configure DADman software and then configure 
sources in the S6, S4, or Avid Control Monitoring page.

To configure DADman: 

1 Launch DADman and make sure you complete each of the following steps before proceeding.

2 Choose Settings > Monitor Profile, then enable and create a monitor profile.

3 Enable EUCON by selecting it from the Settings menu. 

For information on configuring DADman monitoring profiles, see Monitor Profiles.

Monitor profile enabled in DADman

EUCON enabled in DADman
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4 Right-click on any monitor in the profile and assign the EUCON mode to what you want to define as Control Room, Monitor A, Mon-
itor B, Monitor C, and Monitor D by selecting it from the sub-menu. 

Configuring Sources on S6, S4, or Avid Control

To configure sources on S6, S4, or Avid Control:

1 Navigate the touchscreen to the Monitoring page (from the Home screen press Monitoring, or press the Setup 2 switch in the Mon-
itor Controls section of the Master Module). 

All available sources are listed in the Source Select section in the center of the Monitoring screen. Available sources are dark until 
they are assigned. 

2 In the upper Source row, touch the small arrow along the top of the first input source.

The selected input source is outlined in yellow, and the items in the Source Select list become lit (available). 

Assigning EUCON mode in DADman

Available Sources in the Source Select list

2
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3 Tap an available source in the Source Select list to assign it to the selected input source.

When first assigned, input sources are inactive (as shown in the image to the right). After assigning all your input sources you can 
activate them as desired by tapping in the lower third of their block in the upper Source row. 

4 Repeat the previous steps to assign additional input sources. 

Sources can be duplicated and put in any order. 

5 To see additional available sources, scroll the Source Select list up or down. To see additional input source slots (such as 9–16) in 
the Source row, scroll it left or right. 

Additional Monitor Soft Keys

Monitoring Cue Speaker Sources and Cut (mute) are available as Soft Keys. In the default Pro Tools appset, Monitor cue Speaker Cut 
and Sources appear in the Master Post Module Soft Keys. These commands are also available in the Soft Keys Editor, letting you create 
custom Soft Key assignments for monitor control. 

3
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Appendix F: I/O Delays

MTRX II Input to Output Delays
The total system delay has to be large enough to accommodate for the processing latency in the unit. There is almost the same delay on 
all the digital I/O, and any difference is due to an inherit difference of time it takes to sync to the different signals before samples are 
available for time stamping. Digital inputs are time stamped when they enter the matrix algorithm and buffered according to the time 
stamp on all outputs in the digital domain. This maintains phase coherence regardless of audio signal path and processing. Likewise, sig-
nals maintain the same phase whether they are running through the summing process or not. This is still the case for any signal routed 
through an MTRX SPQ card (a DSP/FPGA expansion card for MTRX), but the whole system delay increases automatically to 7 samples 
(SPQ filter processing requires an additional 2 samples).

There is an additional delay with analog I/O—AD (analog-to-digital) and DA (digital-to-analog)—due to the conversion process. This 
delay varies depending on the sample rate. Once digitized, the signal is time stamped and buffered the same as with digital inputs.

The table below provides the delay in samples, based on a system delay of 5 samples, from Input to Output with Pro Tools | MTRX. 

*The delay for Thunderbolt is the delay provided by the transfer from the audio hardware to the DADdriver. In addition there is the buf-
fer delay set for the audio application in use.

MTRX Input to Output delay in samples

Input
Output

DA (1fs) DA (2fs) DA (4fs) AES MADI PHD Dante Thunderbolt*

AD (1fs) 51 18 18 19 20.25 20

AD (2fs) 49 15 15 16 17.25 17

AD (4fs) 47 11 11 12 13.25 13

AES 38 39 41 5 5 6 7.25 7

MADI 39 40 42 6 6 7 8.25 8

PHD 38 39 41 5 5 6 7.25 7

Dante 39.25 40.5 42.25 6.25 6.25 7.25 8.5 8.25

Thunderbolt* 40 41 43 7 7 8 9.25 9

The delays listed above are without enabling ProMon/SPQ. If enabled, all values/channels increase by two samples, which are needed 
for processing.
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Appendix G: Troubleshooting

Disabling Avid Audio Sever to Prevent Clock Disruptions with Sync X
(Mac Only)

When you quit Pro Tools, the Loop Master changes from Sync X to the primary audio interface in the system, and the HDX or 
HD Native Core Audio driver becomes the Clock Master for the primary audio interface in the system rather than your Sync X. These 
changes may disrupt audio outputs of Loop Synced interfaces or those following word clock generated by Sync X (such as MTRX II). 
Disruptions are more significant if the Core Audio driver is set to a different sample rate than Pro Tools. Once Pro Tools is relaunched, 
the Loop Master and Clock Master revert to Sync X.

To prevent the Loop Master and Clock Master from changing (thereby stabilizing the clock) when quitting Pro Tools, disable the Avid 
Audio Server.

To disable Avid Audio Server:

1 Locate Avid Audio Server at /Applications/Avid/AvidAudioServer.

2 Rename Avid Audio Server (for example, rename it to “#AvidAudioServer”).

3 Reboot your computer.

Recovery Mode
The Reconfig button on the back of MTRX II should not be used during normal installation. It is intended only as a recovery function 
in case something goes wrong during a firmware upgrade (such as unintended power loss or a network error). It lets the MTRX II start 
in basic mode so that it can be restored with new firmware without having to be returned to the factory.

The Reconfig button is accessed through a hole in the rear panel using a paper clip, pen, or a similar pointed item. A green LED is visible 
through the hole. When the Reconfig button is activated, the LED lights to indicate the first reconfig mode of the MTRX II and the 3 
LEDs on the front panel light with a yellow color.

Reconfig pushed while the unit is powering up

Green LED ON MTRX II enters Firmware Update mode 1. In this mode, only a basic boot firmware is operative in the unit, and new 
firmware can be downloaded with DADman software. This mode is used if the firmware in the MTRX II is non-operative for some rea-
son. The IP address settings of the unit are the last setting used in the unit.

Reconfig

Apply a short push while the unit is in reconfig mode and the Green LED is on.

Green LED OFF MTRX II changes to reconfig mode 2, which is the same as mode 1 but the IP address setting of the unit is set a default 
IP address 10.0.7.20 / 255.255.0.0. It can take a minute for the IP address to settle. 

The MTRX II will operate with a basic boot Firmware and IP configuration. The MTRX II will not be operational until a proper firm-
ware has been downloaded using DADman software, and it has been restarted. By enabling recovery mode with the default IP address 
and network configuration, the unit can be identified on a network using the default setup. 

Restore defaults

Apply a long push, approximately 10 seconds, while the unit is in normal operation. This forces a restore defaults of all settings in the 
unit. 

In order to leave the reconfig mode and enter normal operation, the MTRX II must be power cycled.

To revert to the default behavior, reinstall the Avid HD Driver and reboot your computer.

Note that the IP address referred to is the IP address of the controller/management interface of the unit. This is not the IP address 
of the Dante IP audio interface. This IP address cannot be accessed in recovery or restore defaults mode.
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Appendix H: Warranty Claims Information
If you experience a hardware failure within 30 days of purchase, you can return your product to your 
reseller for an exchange.

For warranty claims, contact Avid directly: 

https://www.avid.com/learn-and-support/contact-audio-and-music-support

For non-warranty claims, visit: 

http://avid.force.com/pkb/articles/faq/Avid-Audio-Product-Repairs 
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